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Copyright
Documentation
©2020 Allworx Corp, a Windstream company. All rights reserved. No part of this publication may be 
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopy, recording, or otherwise without the prior written permission of Allworx Corp.

Software
Software in this product is Copyright 2020 Allworx Corp, a Windstream company, or its vendors. All 
rights are reserved. The software is protected by United States of America copyright laws and 
international treaty provisions applicable worldwide. Under such laws, the licensee is entitled to use 
the copy of the software incorporated with the instrument as intended in the operation of the product 
in which it is embedded. The software may not be copied, decompiled, reverse-engineered, 
disassembled, or otherwise reduced to human-perceivable form. This is not the sale of the software or 
any copy of the software; all right, title, ownership of the software remains with Allworx or its vendors.

Warranty
This warranty shall not apply to any products to the extent the defect or non-conformance is due to (A) 
accident, alteration, abuse, misuse, or repair not performed by Allworx, (B) storage other than 
specified, (C) failure to comply with applicable environmental requirements for the products.

Environmental Conditions
Allworx servers and phones 

Operating:

Temperature
Relative Humidity

+5° to 40° C / +41° to +104° F
5 to 90% (non-condensing)

Storage:

Low Temperature Point
High Temperature Point
High Relative Humidity Point

-40° C / +40° and any convenient humidity
+66° C / +150° 15% RH

+32° C / +90° 90% RH
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Trademarks
The following trademarks are owned by Allworx:

The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and 
any use of such marks by Allworx Corp., a Windstream company, is under license. Other trademarks 
and trade names are those of their respective owners.

Revision History

Allworx® Verge™ IP phone series
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Allworx® Connect™ 320 server

Revision Date Description
A 21-OCT-2020 Title modification and content update for release 5.1. Including access to Visual 

Voicemail through the Messages tab (Section 6.7).
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Chapter 1 Introduction
Allworx Interact™ provides Windows PC users with an intuitive, configurable user interface for 
controlling an Allworx desk phone (located physically near the user’s PC) or an Interact Softphone 
(running inside the user’s Windows PC). There are three Interact modes:

1. Interact is a free application available to any Allworx user. This basic application mode displays an 
inbound caller’s name and number in a discrete pop-up dialog box on the user’s PC desktop. 

From within this PC dialog box the user can view and answer calls that are incoming to their 
Allworx desktop phone. They can also choose to send the call directly to their Voicemail (Message 
Center) or ignore it. However, calls must be placed using the Allworx phone dialpad.

2. Interact Professional is a per-user licensed application mode that provides an expanded full-
featured user interface and additional capabilities to the basic Interact. 

This expanded user interface window has multiple active panes for Current Calls, Parked Calls, Call 
History, System and Personal Contacts, and a Dialpad. The Contacts pane provides information 
that includes an Allworx user’s presence, availability, and favorite status. With Interact 
Professional, users can simply click once to dial, transfer, park, or record calls.
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3. Interact Softphone is another per-user licensed application mode that allows the user’s Windows 
PC to function as a phone. Calls are managed using the same Interact Professional expanded user 
interface window with the PC microphone and speakers, or a PC headset (preferred), for audio 
hardware instead of an Allworx desk phone. 

Where a traditional Allworx desk phone associates functions with physical buttons (PFKs), Interact 
Softphone enables those features from the Allworx server and provides indications within the user 
interface. For example, a Message pane is included in the expanded user interface to provide 
Softphone users with an indication of new voice messages and access to the Message Center. 

Note: An Interact Softphone license allows the user to switch between controlling a Softphone and 
controlling an Allworx desk phone, based on the handsets assigned to the user by the Allworx server 
administrator.

1.1 Who Should Read this Guide
This guide is for individual users and Allworx administrators who install, configure, and use Interact 
application software.

1.1.1 Guide Organization
This guide is organized by the layout of the user interface and each chapter provides step-by-step 
instructions for using the features provided within the specified area of the user interface. For a cross 
referenced list of the most common call management tasks discussed throughout this document, see 
“Task Table” on page 91.
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1.2 Equipment Requirements
The following table provides a list of the equipment requirements necessary to perform the 
procedures described in this document.

Equipment Requirements

PC •  Running OS (with latest service pack)

•  RAM minimum: 2 GB
•  Monitor resolution: 1024 x 768 (XGA)
•  Internet connection
•  Allworx Interact application with Interact Professional, Interact Softphone, Interact Sync, if needed 
•  Microsoft .NET Framework 4.5.1 
•  Administrative permission for the PC for application installation
•  For Interact Softphone: Audio hardware suitable for business telephony; Allworx suggests 

headsets certified by Microsoft (https://docs.microsoft.com/en-us/skypeforbusiness/
certification/devices-usb-devices)

Allworx Server •  Allworx username and password
•  Allworx System Software Version 8.6 (minimum required for Interact Softphone), 7.5.9.4 (minimum 

for basic Interact and Interact Professional), but 7.5.19.1 or higher is preferred.
Notes:
•  Not all Interact Professional features will work with Allworx System Software 7.7 and lower.
•  Allworx System Software version 8.5 and higher requires using Interact Professional version 4.0 

or higher.

•  IP Address or DNS name of each Allworx server
•  Administration permissions and passwords for each Allworx server
•  Feature key for Interact Professional or Interact Softphone
•  Feature key for Interact Sync (for Allworx System software 8.1 and lower)
•  Feature key for Automatic Call Distribution
•  Visibility to the Allworx View Server (also requires the View CDR function key - minimum)

Allworx IP Phones

(For Interact and 
Interact 
Professional only)

•  92xx IP Phones
•  Verge IP phone series

•  Windows 7, 32- and 64-bit (SP1) •  Windows 8/8.1, 32- and 64-bit •  Windows 10, 32- and 64-bit
•  Windows Server 2012/2012R, 2016, and 2019

https://docs.microsoft.com/en-us/skypeforbusiness/certification/devices-usb-devices
https://docs.microsoft.com/en-us/skypeforbusiness/certification/devices-usb-devices
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1.3 Product Comparison
Note: Interact with support for Interact Softphone can only be used with Allworx Connect Servers 
running System Software version 8.6 or higher.

Basic Interact 

(using pop-up dialog 
box only) 

Allworx Interact 
Professional and 

Interact Softphone

(using expanded 
Interact Professional 

user interface)
 

Call Handling

Answer / Ignore / End / Place on hold

Transfer / Park / Conference

Interact Features

Access to the Allworx system directory, call history, and contacts

Access to Microsoft® Outlook® application

Access to application settings Limited

Access to handset call history

The following features require Allworx System Software 7.7 or higher.

Access to call queue status1

Access to call queue agent status (call supervisors only)1

Wipe current device

Change Allworx Password

Intercom call
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Call queue features1

The following features require Allworx System Software 8.0.7.6 or higher.

Change Allworx PIN

Record All

Access to agent login features1

Launch the Allworx View application2

The following features require Allworx System Software 8.0.8.6 or higher.

Interact Sync3

The following features require Allworx System Software 8.1 or higher.

Five- and six-digit extension dialing

The following features require Allworx System Software 8.2 or higher.

Contacts 4, 6

Bluetooth Support5

Call Handoff5

Answer an ACD call regardless of ACD Queue logged in Status1

Customizable keyboard shortcuts

Receive a notification when an Allworx User extension is 
available

Basic Interact 

(using pop-up dialog 
box only) 

Allworx Interact 
Professional and 

Interact Softphone

(using expanded 
Interact Professional 

user interface)
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Hide Interact Professional / Interact Softphone application in the 
Windows System Tray

The following features require Allworx System Software 8.5 or higher.

Park to Extension7 

Conference calls 

The following features require Allworx System Software 8.6 or 
higher.

Interact Softphone

Messages tab for Interact Softphone access to Visual Voicemail

1 Requires the following:
•  Allworx Automatic Call Distribution feature key
•  User assigned as an agent to one or more call queues
•  Interact Professional handset with an ACD PFK assigned or the ACD Appearance or Queue Appearance 

programmable function(s) assigned to an Interact Softphone handset

2 Requires the following:
•  Allworx View CDR feature key 
•  Connection between the Allworx server and the View server.

3 Requires the following:
•  Interact Sync feature key (one feature key enables the feature for all Allworx users)
•  Microsoft Skype for Business 2015 or 2016 installed
•  Microsoft Outlook 2010, 2013, or 2016 installed
•  Google Chrome™ version 41.0.2272 (minimum)
•  Mozilla Firefox® Version 38.0 (minimum)

4 Personal Contact management requires an Allworx Connect series server.

5 Requires the Verge 9312 IP Phone for Interact Professional.

6 External Personal Contacts are not synchronized with the Verge 9304 IP Phone.

7 Compatible with Interact application version 4.0 or later — including Interact 5.0 with support for Interact Softphone.

Basic Interact 

(using pop-up dialog 
box only) 

Allworx Interact 
Professional and 

Interact Softphone

(using expanded 
Interact Professional 

user interface)
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Chapter 2 Installation
This chapter describes how to install the Interact application and then how to log in to Interact 
Professional and Interact Softphone.

A single Interact installation file provides the needed options for installing all Interact modes 
(including Softphone) and Interact Sync. Both Interact Sync and Softphone are selections that can be 
made during the installation. For information about the available Interact modes, see “Introduction” on 
page 1.

To enable Interact Professional, the Allworx Server Administrator needs to provision an Allworx 
Interact Professional license for each user. When the user logs in after that license becomes available, 
they automatically have the Interact Professional version of the application. If no license is available, 
they see the basic Interact version of the application.

The Interact Softphone software is delivered with Interact software, and users with an Interact 
Softphone license can use their PC as a phone ― with the expanded Interact user interface and the PC 
microphone and speaker for audio hardware (instead of Allworx desk phone hardware). An Interact 
Softphone license also allows the user to switch between controlling a Softphone and controlling an 
Allworx desk phone.

Notes: 

• The basic Interact application is automatically available to users without the need to purchase 
licenses. 

• If a user has an Interact Softphone license assigned, they do not also require an Interact 
Professional license.

2.1 Checklist
Complete the following steps in this order for a successful installation. Click the links in the More 
Information column for additional details.

Step Description More Information

Download and Install the Interact Application

Note: 
•  You must have administrator rights for the PC on which the application will be installed.
•  Allworx Connect server needs a Feature Key for the number of Interact Professional and/or Interact Softphone handsets 

needed, and these Feature Keys must be installed prior to installing and logging in to those applications.
1 Allworx Connect server must be running the appropriate version 

of the Allworx System Software.
See “Equipment Requirements” on page 3

2 The Allworx server administrator may create Handset 
Configuration Templates for some classes of users (e.g. add 
the ACD function to a template for Softphone ACD users).

See the Allworx System Software 
Administrator Guide.
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2.1.1 Interact Application Licensing
With an Interact Professional license, each user with a license can run the software simultaneously on 
as many PCs as needed. The description on the license changes to reflect the name of the most 
recent PC on which it was started.

This description also applies to an Interact Softphone license when using the Interact Professional 
features to control Allworx desk phones. However, when using the Softphone inside the Windows PC, 

3 The Allworx server administrator completes one of the 
following tasks:
•  Create the required handsets, assign them to users, and 

adjust the handset configuration for each handset.
•  Make some Interact Softphone users eligible to create the 

required handsets and configure the Handset Configuration 
Template to be used for those handsets.

Note: Users who have been assigned an Interact Softphone 
handset, or are eligible to create their own, will find that option in 
the Handset Selection dialog box when logging into Interact. The 
description for an Interact Softphone handset always includes 
the PC hostname of the last place that handset was used.

See the Allworx System Software 
Administrator Guide.

4 Download the Interact application from the following location: 

http://get.allworx.com/interact/

See “To install the application:” on page 9.

5 Double-click the downloaded installer to start the installation 
wizard.

6 Click Next.
7 Accept the End-User License Agreement and click Next.
8 Click to select to install Interact Softphone or leave the 

selection blank to not install Softphone.
9 Click Next.

10 Configure the application shortcut by checking the box and 
click Next.

11 The Ready to Install dialog box opens. Click Install to begin.

Follow the instructions in the setup wizard.
12 Click Finish to complete the installation and launch the 

application.

Log in to the Interact Application
9 Launch the Interact application See “To log in to the application:” on 

page 10.10 Enter the Allworx Username and Password. 
11 Enter the Allworx Server IP address.
12 Click Login.

Step Description More Information

https://allworxportal.com/support_training/software.aspx
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the license can be used for multiple locations but not simultaneously. One license equals one handset 
(including its configuration), and that license can migrate from one PC to another (e.g. desk phone by 
day and Softphone in a laptop at night). For multiple locations and simultaneous uses of Softphone, 
multiple Interact Softphone licenses are required. The Allworx server administrator must create 
multiple Interact Softphone handsets, each with their own configuration.

2.2 Installing and Logging In to the Application
Note: The Interact application supports Terminal Services/Remote Desktop Services on Windows 
Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2 using the 
Enterprise installer. The Enterprise installer also supports deployment through Group Policy Objects.

To install the application:
1. Navigate to http://get.allworx.com/interact/ to locate and download the appropriate application 

installer file.

2. Double-click the downloaded installer. The Interact Setup Wizard dialog box opens. 

3. Click Next.

4. Accept the End-User License Agreement and click Next. 

5. Select an Interact Sync setup option.

6. Click to select to install Interact Softphone, or leave the selection blank to not install Softphone.

7. Click Next. Configure the application shortcut by checking the box.

Option Description
Do not install Interact Sync. I will 
install it later if I need it. 

Bypasses the Interact Sync installation step. This is the default setting.

Install Interact Sync now 
(Administrator 
access required.).

Installs Interact Sync. 

Installing this feature requires:
•  Interact Sync feature key (one feature key enables the feature for all 

Allworx users)
•  At least one of the following:

•  Microsoft Skype for Business 2015 or 2016 installed 
•  Microsoft Outlook 2010, 2013, or 2016 installed
•  Google Chrome
•  Mozilla Firefox

Option Description
Create a shortcut for Interact on the desktop Places a start up icon on the computer desktop. User double-

clicks to activate application.

Start Interact automatically when I log in Log in to the computer, and Interact automatically initiates.
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8. Click Next. The Ready to Install dialog box opens. Click Install to begin.

9. Click Yes in the User Account Control window, if prompted.

10.Click the Launch Interact check box. 

11.Click Finish to complete the installation and launch the application.

To log in to the application:
1. Launch the Interact application.

2. Enter the Allworx Username and Allworx Password in the dialog box. 

3. Enter the Allworx Server IP address. If the IP address is unknown, click Find Server IP.

Notes:
• If needed, ask the Network/System Administrator responsible for client PCs on the network the IP 

address of the server, and enter the IP address manually.
• Ask the Allworx administrator to add a firewall exception on the workstation for the Interact 

application.
• On first use of Interact Softphone, the user should click on the Audio Device Selection icon and 

select appropriate devices for Microphone and Speaker. This selection can also be made by 
selecting Audio Devices from the settings icon ( ) drop-down list.

4. Click Login.

After clicking Login, one or more of the following notifications may appear: 

Application Mode Behavior
Interact The application icon is visible in the Windows System Tray.

Interact Professional and 
Interact Softphone

The application opens and displays the full-featured user interface, and the application 
icon is visible in the Windows System Tray which is by default in the lower, right corner 
of the PC screen.

Note: If the application was closed while hidden, the application re-opens hidden 
(minimized to the Windows System Tray).

Notification Description
Handset Selection Displays if the user has multiple assigned handsets. 

•  Click to select a handset from the drop-down list. 
•  Click Create a Softphone handset if available. This option is only available if the 

Allworx Administrator has made the user eligible. 
•  Click OK to continue logging in to the application.

Install Interact Sync Displays when the Interact Sync option is not installed and informs users of the 
additional benefits of installing Interact Sync to use with Interact Professional and 
Interact Softphone. 
Select an available option; the recommended option is Install Interact Sync now 
(Administrator access required).
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5. Download the supporting documentation from http://get.allworx.com/interact. 

6. Place a test phone call. See “Managing Calls” on page 21 for more information. 

2.3 Changing the Allworx Password or Allworx PIN
Initiate a change to the user login password (for application login) or PIN (for access to ACD queues, 
Allworx Message Center, etc) from the settings ( ) drop-down list. To make the change, users must 
supply both old and new passwords or PINs during the request in the dialog box. The new password or 
PIN must comply with the Allworx System Software requirements.

To change the login password or PIN:
1. Log in to the application, and then follow the steps for one of these options:

2. Enter the required information in the pop-up dialog box

3. Click OK. 

A notification displays indicating the request was successful. Click OK in that pop-up window to 
return to the application.

Notification Description
Update is available Displays when there is an Interact application upgrade available. 

Click Yes to update the application or click No to continue logging in to the application.

Change password Displays if the Allworx administrator requires the user to change the current Allworx 
password. Follow the prompts to change the current password. See “Changing the 
Allworx Password or Allworx PIN” on page 11.

Set your user image Displays when the user who is logged in to the application does not have a contact 
image.

Click Yes to update the contact image or click No to continue.

Sync contacts with 
Outlook

Displays the first time the Interact Professional or Interact Softphone user logs in to 
synchronize Outlook contacts with Personal Contacts.

New Outlook contacts 
found

Displays when the Interact application has found new Personal Contacts in the Outlook 
application. 

Note: This is only available on Verge IP phones using a Connect server.

Option Interact Basic Interact 
Professional

Interact 
Softphone

Interact Icon in the Windows System Tray or on the Interact 
application Settings icon > Settings and select: Change 
Password or Change PIN

From the settings menu ( ) navigate to Options > 
Change Password or Change PIN.

https://get.allworx.com/reach
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2.4 Connecting Headsets
Both the Interact and Interact Professional applications connect to an Allworx Verge phone and the 
headsets are connected to those phones as indicated in the user guides for the Allworx 92xx and 
Verge series IP phones. These documents are available on the Allworx website Partner Portal 
(allworxportal.com).
Interact Softphone allows users to place and receive calls using their Windows PC - without 
connection to an Allworx phone. As a consequence, wired (preferably USB) and Bluetooth headsets 
are connected to the PC itself as directed in that equipment’s documentation.

Note: For information about recommended headsets, see the document titled “Allworx Headset 
Compatibility Guide” that is available at allworxportal.com.

https://www.allworx.com/resources
https://allworxportal.com/
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Chapter 3 Application User Interface Overview
There are two user interfaces for managing calls in the Allworx Interact application modes. The first is 
a pop-up dialog box that is available for all three applications modes and appears in the lower right 
corner of the PC desktop when there is an incoming call. Basic Interact connects to an Allworx desk 
phone and this dialog box is the only way to answer a call, put a call on hold, or end a call on a PC 
when using that mode.

For all Interact application modes, click one of the following actions in this dialog box:

The second user interface provides expanded call management features for both the Interact 
Professional and Interact Softphone application modes.

An Interact Professional license, like basic Interact, connects the user’s PC to an Allworx desk phone 
and has those same capabilities, but adds the abilities to place, transfer, park, or conference a call. 
Additionally, Interact Professional provides access to Call History, Queue Status, as well as Allworx 
System, User, and Personal Contacts. All features are accessed from the Interact Professional user 
interface.

An Interact Softphone license allows the use of the expanded Interact user interface to run a phone 
entirely within the Windows PC using the full-featured Interact Professional user interface. Depending 
on the configuration defined by the Allworx server administrator, this license can also allow user’s to 
manage calls through their Allworx desk phone. 

For detailed information about implementing the Interact Professional user interface features, see 
“User Interface Window” on page 51. This user interface uses visual cues for call status and User 
Contact presence, availability, and favorite status. 

Action Description

Answer Accepts the call.

To VM Transfer the call to Voicemail (Message Center).

Ignore Stops the ringing of the incoming call and dismisses the dialog pop-up.

Open Interact

(not available for 
basic Interact)

Opens the minimized Interact Professional / Interact Softphone expanded user interface.

This option is not available in the dialog 
box for basic Interact.
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The following screen is an example of the expanded, full-featured user interface window used with 
Interact Professional and Interact Softphone. 

The main user interface window (page 14) provides the flexibility to customize the display and 
position of the panes within the window to accommodate user preferences. Users can set the 
preferences listed in the following table.

Note: For information about how to define the panes that are visible within the user interface window, 
see “Adjusting Application Settings” on page 39.

Preference Description

Slide-to-hide tab Click to open the window. Click the Unpinned active icon to keep the window open. The 
window is available to undock from the main application window.

Pin or Unpin Click the Pin active icon for each window to keep that window visible while docked in 
one of the slide-to-hide panels. 

Resize Open each window within the main application screen and manage the windows size 
without using valuable computer screen space. 

Continued

Station Appearances

Active
Window

Action
Area

Slide-to-
Hide Open

Windows

Call Recording

Presence SettingMute

Do Not Disturb

Caller ID Name/Number

Volume Control / Softphone 
Audio Device Selection

Application Settings Menu

Status
Bar
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3.1 System Tray 
All of the Interact application modes display the icon in the Microsoft Windows system tray (by default 
in the lower, right corner of the PC screen). Right-click the Interact icon to select one of the 
configuration options. 

Preference Description

Undock or dock Place the windows on top or under the main application menu window (maximized 
applications can obscure the view). 
Undocked windows Detaches the current window from the main application screen 

for custom size and placement. All windows close when exiting 
the Allworx Interact Professional or Interact Softphone 
application mode and open in the same location when 
relaunching the application. 

To undock the window:
1.  Pin open the windows prior to undocking the window, see above. 
2.  Double-click or click and drag the title bar of the application window.
3.  Move and adjust the window.

Docked windows Returns the window back to the main application window.

To dock the window:
1.  Double-click the window title bar or click and drag the window back 

to the main application window.
2.  Drag the window to one of the placement targets shown on the 

application.

Shortcut: To return the undocked window to the original, 
docked position, double-click the undocked window title bar or 
window header.

X Makes the window invisible in the docked or undocked state. 
To make the window visible, navigate go to the Settings menu. 
See “Adjusting Application Settings” on page 39 for more 
information.

Sample window
placement options
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The available options are: 

Note: See “Adjusting Application Settings” on page 39 for detailed information about each option. 

3.2 Icons
The expanded user interface uses icons to navigate through the Interact Professional and Interact 
Softphone application modes, view the status of a call or user contact, and manage calls. The 
presence status icons and availability status apply to User Contacts only. 

The following sections show and describe the icons available in the expanded user interface.

3.2.1 Navigation Icons
Navigation icons direct the user to panes within the window or menus to access the features available 
within the Interact application.

• Show Active Call window or Hide Active Call window* • Launch Allworx View**

• Update (displays only when a software update is 
available)

• Find out more

• Options... • About

• Change password • Logout <username>

• Change PIN • Open

• Reset UI configuration* • Exit

*   Available only with Interact Professional and Interact Softphone licenses

** Available only with Interact Professional and Interact Softphone licenses and an Allworx 
View license

Active Calls pane Agent: <name> pane

Current Calls pane Dialpad pane

Outside Lines pane Parked Calls pane

Queue Status pane Settings

New Interact software is available.
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3.2.2 Status Icons
The status icons provide a visual cue of contact type, presence status, and call status.

3.2.3 Action Icons
The action icons allow users to customize the user interface and use the application to manage calls. 
Click the icon to activate the feature.

Contact image icon - red corner indicates an 
Allworx contact.

Contact favorite.

Contact is not a favorite. Presence Status - On Business Trip.

Presence Status - Busy. Presence Status - At Home.

Presence Status - At A Meeting. Presence Status - Away.

Presence Status - On Vacation. Presence Status - Unknown.

Call Status - Incoming call or call answered 
elsewhere

Call Status - Outgoing phone call, no answer.

Call Status - Incoming, missed call. Call Status - Outgoing phone call.

Application error icon, such as BLF lost, 
Interact lost connection, running out of 
recording space etc.

Note: When this icon appears next to the 
Presence pull-down, it indicates a loss of BLF. 
The icon may flash on and off to indicate an 
intermittent loss. For more information, refer to 
the Miscellaneous heading in “Troubleshooting” 
on page 85.

Notify when available activated for Allworx 
User Contact.

Number of new messages available through 
Visual Voicemail or the audio Message Center. 
(Available for Interact Softphone only)

Closes pan within the application user 
interface. Sets an undocked window to 
invisible. See “Adjusting Application Settings” 
on page 39 to reactivate window.

Note: If the application was closed while 
hidden, the application re-opens hidden 
(minimized to the Windows System Tray).

Pinned pane - the pane is available for 
undocking.

Unpinned pane. The pane is available for the
Slide-to-Hide option.

Do Not Disturb is Inactive.

                                                               Continued
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3.3 Wipe Current Device
The Wipe remote devices option in the Allworx System Administration web page allows the Allworx 
server administrator to remove all login credentials and voicemail information for a lost or stolen 
remote device. Additionally, this feature disables the device from sending and receiving phone calls. 
This option requires the Allworx server administrator to change the user password. Information about 
this procedure is available in the Allworx System Software Administrator Guide that is available on the 
Partner Portal (https://allworxportal.com/)

To use the Interact application after receiving a wipe command, log in using the current credentials 
and the new password provided by the Allworx server administrator. See “To log in to the application:” 
on page 10 for more information. 

Do Not Disturb is Active. Mute is Inactive.

Mute is Active. •  Opens Volume Control to set the loudness of 
ringtones and speaker phone on an Allworx 
desk phone for Interact Professional.

OR
•  Opens the Audio Device Settings dialog box 

to select the audio device(s) for the 
microphone, speaker, and ringtone for 
Interact Softphone using PC audio hardware 
or other handset, as well as adjust volumes.

Note: The Volume Control ion is not available 
when using Interact Professional with a 92xx 
series Allworx Phone.

Pause Call Recording. Resume Recording.

End Call Recording. Begin Call Recording.

Search - Call History and Contacts panes. More Options - Call History and Contacts 
panes.

Add Contact - Contacts pane. Single Column Display - Contacts pane.

Multiple Column Display - Contacts pane. Name/Favorite Status Display - Contacts pane.

Backspace - Dialpad pane. Place a phone call from the Dialpad pane. 

Note: Click twice to redial the last number.

https://allworxportal.com/
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3.4 Interact Sync
Interact Sync is a customizable plug-in for Interact that allows click-to-dial capabilities between the 
expanded user interface and versions of Skype for Business 2015 or 2016, Microsoft Outlook 
applications, and the Google Chrome and Mozilla Firefox web browsers installed on the PC. 
Additionally, Interact Sync supports synchronization between the Allworx Interact Presence and the 
availability setting in Skype for Business, Microsoft Outlook, and the Allworx phone. 

For more information, see “Interact Sync” on page 79.
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Chapter 4 Managing Calls

Use the Interact application modes to manage incoming and outgoing phone calls using a PC. Basic 
Interact and Interact Professional manage calls through Allworx phones, while Interact Softphone is 
able to place and receive calls directly from a Windows PC without a connection to an Allworx desk 
phone. The following common call management features are discussed in this chapter. Features not 
available within the basic Interact dialog box are available through the Allworx desk phone.

Note: A full list of Interact features and where information about those features can be found in this 
document is included in Appendix A “Task Table” on page 91.

Feature
Basic Interact 

(using pop-up dialog box 
only)

Interact Professional 
and Interact Softphone
(using expanded Interact 

Professional user 
interface)

 
Place a call

Answer a call

Place a call on hold

End a call

Answer a call in a queue

Transfer a call

Intercom call

Conference call

Park a call

Supervise a call

Emergency Alerts
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To avoid disconnecting a call when answering a second incoming call, it is recommended that your 
Allworx System Administrator configure your phone’s Handset Preference Group to enable Auto On 
Hold, or you can configure your Allworx desk phone as indicated in the following table. 

4.1 Placing a Call
Use one of the following options to place a call from the user interface:

To place a call using an Allworx desk phone:
Pick up the handset or press the speaker phone soft key, and then dial a number. After dialing the call, 
the Interact application displays the pop-up dialog box with the Cancel button. Press the Cancel button 
to stop placing the call.

To place a call using the expanded user interface Call History or Contacts pane:
1. Locate a listing in the appropriate pane of the user interface.

2. Select that listing by double-clicking it or by right-clicking and selecting Dial or Intercom from the 
drop-down list. 

Phone Phone Navigation

92xx IP Phones CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu. When 
prompted to Save to Flash, press the Yes soft key.

Verge IP phone series Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press 
Back to return to the Settings screen and Back again to return to the Idle screen.

Option Basic Interact 
(using pop-up dialog box)

Interact Professional 
Expanded User Interface
(through an Allworx desk 

phone)

Interact Softphone 
Expanded User Interface

Allworx Desk Phone

Note: With basic Interact, calls 
can only be placed using the 
Allworx desk phone. Calls 
cannot be placed using the 
pop-up dialog box.

Call History pane

Contacts pane

Dialpad pane
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3. If the Allworx User Contact is busy, right-click that listing in the Contacts pane and select Notify 
when available from the drop-down list. When the Allworx user’s extension becomes available, the 
user interface displays a pop-up notification message.

To place a call using the expanded user interface Dialpad pane:
See “Dialpad” on page 69 for more information.

To place a call using Skype for Business:
Open the Skype for Business application and take one of the following actions:

1. Right-click a main contact listing to display the context menu and click to select Allworx Dial from 
the menu.

Allworx User Contact is Busy Notify when available Active Pop-up notification
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2. Click the “…” menu on a conversion window and click to select Allworx Dial in the pop-up menu.

3. Click the participant list, then right-click the user and click to select Allworx Dial from the pop-up 
list.
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4.2 Answering a Call
The following notifications display on the PC screen when there is an incoming call:

To answer a call from the pop-up dialog box:
For incoming calls, a pop-up dialog box displays the caller ID name/number and call management 
options. Click one of the following options:

To answer a call in the expanded user interface Current Calls pane:
For incoming calls, the Current Calls pane displays call information and call management options. 

Notification
Basic Interact 

(using pop-up dialog box)

Allworx Interact 
Professional and Interact 

Softphone
(using expanded Interact 

Professional user interface)

Pop-up dialog box

Current Calls pane opens

Option Description
Answer Accept the call.
Ignore Silences ringing and dismisses the dialog for that call. This is the same as pressing the Allworx 

phone Silent soft key.

Pane Feature Description
State of the Current Calls Pane
Unpinned The window opens (auto pins), and then automatically closes the window when the call ends. 
Pinned The window does not close when the call ends.
Displayed Information
Incoming call listing •  Status icon/call details.

•  Caller ID name and number.
Call Notification Pop-up indicating an incoming call with the caller ID name and number.
Call Management Options
Answer Displays the call in the Current Calls window and accepts the call.
Ignore Displays in the Current Calls window and silences ringing. Click Answer to retrieve the call. This 

behavior is the same as pressing the Allworx phone Silent soft key.
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To answer another user’s call from the expanded user interface Contacts pane:
The contact listing flashes red when there is an incoming call. 

1. Right-click the Contacts pane listing.

2. Click to select Answer from the drop-down list.

4.2.1 Answering a Call in a Queue
To be able to answer incoming calls to ACD or Ring All queues, the Allworx Server Administrator adds 
Programmable Function Keys (PFKs) to Allworx desk phones, or Programmable Functions to Interact 
Softphone. 

Note: The appropriate Feature Keys must be installed on the server prior to defining these queue 
functions.

All calls, including calls to ACD and Ring All queues, appear in the Current Calls pane and can be 
answered from there. ACD queue agents have the additional option of answering the call from the 
Agent <name> tab located in the bottom left of the Interact expanded user interface window. 

For more information, see “Agent: <name>” on page 52.
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4.3 Placing a Call On Hold
The Hold feature allows the temporary interruption of the connection between the callers without 
disconnecting the call. 

To place a call on hold:

Follow the steps included in the following table.

4.4 Parking a Call 
The expanded user interface provides access to the System Park and Park to Extension features for 
both Interact Professional and Interact Softphone. For more information see “To park a call:” on 
page 66.

Hold Feature
Basic Interact 

(using pop-up dialog box)

Allworx Interact Professional and 
Interact Softphone

(using expanded Interact Professional 
user interface)

Privacy Hold Click Hold in the Interact pop-up dialog box 
(default is the lower, right-hand corner of 
the computer screen).

Click Hold in Current Calls pane of the user 
interface. The call listing displays the 
following information: 
•  status icon/call status
•  call duration
•  caller ID name and number
•  End Call and Resume buttons

Shared Call Appearance 
Privacy Hold or 
Shared Hold

Click Hold from the drop-down list in the 
Interact pop-up dialog box to select the 
preferred option. The default behavior is 
Shared Hold.

Click the Hold drop-down menu in the 
Current Calls pane of the user interface to 
select the preferred option. The default 
behavior is Shared Hold.

Resume a held call Click Resume in the Interact pop-up 
window.

Click Resume in the Current Calls pane.

Disconnect the current call Click End Call in the Interact pop-up 
window.

Click End Call in the Current Calls pane.
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4.5 Supervising a Call
The ability of a user to supervise calls is defined by the Allworx system administrator when the user is 
created (Handset Preference Group) and when the PFK (Allworx desk phone) or Programmable 
Function (Interact Softphone) is assigned to the handset (see the Allworx System Software 
Administrator Guide for information). 

To supervise the call use the PFK on the Allworx desk phone for Interact Professional. 

For Interact Softphone, click to open the call appearance drop-down menu and select the appropriate 
mode of call supervision.

Or, right-click on the Contact or Call History pane listing and select the supervise mode from the drop-
down list. 

Select one of the following options:

Supervise (Whisper) - This selection allows the supervisor 
to speak to the user without the caller hearing the conversa-
tion. 

Supervise (Monitor) - The supervisor cannot speak with 
either party on the call.

Supervise (Barge) - The supervisor can fully participate in 
the call with both parities.

Note: This user has three Call Supervision Programmable 
Functions assigned to the handset -- one for each Supervise 
mode.
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4.6 Ending a Call
Click End Call in one of the following locations:

4.7 Placing an Intercom Call
The Intercom feature displays in the expanded user interface for Interact Softphone at all times, and 
for Interact Professional only if the Allworx desk phone supports the feature. 

• If that call appearance is currently in use, the Interact Professional application hides the option on 
the right-click drop-down list. 

• If all other default call appearances are unavailable the application uses the Intercom appearance. 

To place an Intercom call (option 1):
1. Open the Call History or Contacts pane and right-click the appropriate listing. Select Intercom from 

the drop-down list.

2. Wait for the tone accompanied by a single ring. The Allworx desk phone or Softphone on the 
receiving end automatically answers the call (default). Begin speaking when the call is answered.

Note: Intercom calls to external phone numbers ring as a normal call.

Location
Basic Interact 

(using pop-up dialog box)

Allworx Interact 
Professional and Interact 

Softphone
(using expanded Interact 

Professional user interface)

Pop-up dialog box 

Current Calls pane
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To place an Intercom call (option 2):
1. Locate the station appearance and click the drop-down arrow for the default line. Click to select 

Intercom from the drop-down list.

2. Double-click a listing in the Contacts or Call History pane or use the Dialpad. Begin speaking when 
the call is answered.

4.8 Receiving Emergency Alerts
Allworx System Software provides the Allworx System Administration web page for access to settings 
that allow users to receive Emergency Alerts on the Verge phones and on the expanded Interact user 
interface window when using Interact Softphone. For more information on these server settings, see 
the Allworx System Software Administrator Guide available on https://allworxportal.com/.

In order to receive Emergency Alerts for Interact Professional, a Programmable Function Key (PFK) 
must be created on the Allworx desk phone. For more information, see the appropriate phone user 
guide available on the Allworx portal. No Emergency Alert message is displayed on the expanded user 
interface window for Interact Professional - only the Allworx phone indicators are available.

To receive Emergency Alerts when using the Interact Softphone application mode, the Handset 
Emergency Alert Programmable Function must be added for the handset. When a call is made to the 
emergency number defined in the handset Dial Plan a flashing pop-up window appears on the 
expanded Interact user interface.

https://allworxportal.com/
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In addition to the pop-up window, an audible alarm sounds for the duration defined by the Allworx 
server administrator in the Interact Softphone Programmable Function. 

• Click Silent to stop the audible alarm but continue to display the pop-up window.

• Click Dismiss to silence the audible alarm and stop the display of the current alert.

• Click X to close the pop-up window.
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Chapter 5 Status Bar Features
Note: The information in this chapter applies only to the Interact Professional expanded user interface 
used to manage calls through an Allworx desk phone or Interact Softphone. These features are not 
available with basic Interact.

The status bar appears at the top of the expanded user interface window and provides access to the 
following features:

• Do Not Disturb (DND) 

• Mute

• Volume levels / Softphone Audio Device Selection

• Call recording 
• Phone line access through station appearances
• User presence settings

• Caller ID name and extension

• Application settings

DND

Volume Control / Softphone 
Audio Device Selection

Mute
Call Recording

Station Appearance

Presence Settings

Caller ID Name and Number

Settings
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5.1 Using DND (Do Not Disturb) 
When activated, the DND feature stops the handset (Allworx desk phone or Interact Softphone) 
connected to the application from ringing. Users can continue to place calls from the application user 
interface or the Allworx desk phone. 

5.2 Muting a Call
When invoking the Mute feature on an active call, the individual at the other end of the call can no 
longer hear the user. 

5.3 Adjusting Volume Levels and Selecting Audio Devices
Click the speaker icon ( ) to adjust the volume levels for the handset, speaker, headset, Bluetooth, 
ringer, and paging by sliding the adjustment bar to the left (quieter) or right (louder). The Bluetooth and 
headset options are available only when that device is connected to the Allworx desk phone or to the 
PC for Interact Softphone. 

Action Description
To activate DND Click the DND button ( ). 

•  All calls follow the next step in the active call route.
•  It is possible to activate the DND option during an active call. Doing so activates the 

feature for subsequent incoming calls.

To deactivate DND Click the DND button ( ) a second time. 

Action Description
To activate mute Click the mute icon ( ). 

To deactivate mute Click the mute icon ( ) a second time. 

Allworx Desk Phone Volume Control Interact Softphone Audio Device Settings
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5.3.1 Selecting an Interact Softphone Audio Device
Interact Softphone allows the user’s Windows PC to function as a phone. With that capability, the user 
can use the existing PC audio devices, or they can add headsets, microphones, and speakers that are 
compatible with their PC and attached through USB (recommended) or Bluetooth.

To select an audio device or ringtone:

1. Click the speaker icon in the Status Bar ( ).

2. Click the drop-down arrow to select the appropriate Microphone, Speaker, or Ringtone.

3. Click Test to try out the selection.

4. Click Stop to end the test.

5.4 Recording a Call
The call recording feature allows users to start, pause, resume, and stop the recording of the current, 
active call (including conference calls). During the active call the user interface provides a status 
indicator by showing a red dot in the Current Calls pane listing.

The Allworx administrator must enable the Call Recording feature for the user. Programmable 
Function Keys (PFK) can be defined on the Allworx desk phone for Interact Professional. Interact 
Softphone has call recording enabled by default without defining it as a programmable function.

Allworx desk phones support the call recording instances listed in the following table. 

Call Recording 
Limited to Non-

Conference Calls

Call Recording a 
three-way 

conference call
Call Supervision

Call Recording a 
four-way 

conference call
9202E phone

Call Recording Indicator
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The call recording features in the expanded user interface window include the following actions for 
both Interact Professional and Interact Softphone:

• Recording automatically pauses when the user places a call on hold. Recording automatically 
resumes when the user resumes the call.

• Recording automatically stops when parking, transferring, or ending a call. 

• Users can manually pause and resume recording for any active call from the Status Bar.

Note: When resuming a previously paused recording, this feature inserts a beep/tone into the 
recording as a marker and displays a recording indicator.

• Both applications stop call recording when using a Shared Call Appearance to place the call on a 
public or bridged hold. A shared call appearance private hold request works the same as a regular 
appearance. 

The Record All feature can be set by the Allworx Server Administrator using the Allworx System 
Administration web page and when the user navigates to Options > Recording in the settings ( ) 
drop-down list. This feature automatically captures call recording audio files for all calls from the time 
the Interact Professional or Interact Softphone user answers the call or launches the application. 
While the Record All feature is active, the recording features – pause/resume/stop – are available as 
usual. If there are no available audio channels for recording, both applications display a pop-up 
message. When launching either application during an active call with the Record All option enabled, 
the application inserts three beeps to signal the start of the call recording and there was previously 
unrecorded information from the phone call.

During a phone-hosted conference call, each active call has its own recording file. The recording 
feature stops when ending an active call within the conference call or when ending the entire 
conference call. To change the Call Recording File Location, Record All capability, or Volume see 
“Recording” on page 50.

9204 phone

9212 phone

9224 phone

Verge series

Interact Softphone

Call Recording 
Limited to Non-

Conference Calls

Call Recording a 
three-way 

conference call
Call Supervision

Call Recording a 
four-way 

conference call
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To record an active call:

5.5 Placing a Call From a Specific Call Appearance or Line 
Appearance

The station appearance selected from the status bar drop-down list remains active until another 
option is selected by the user.

To select the call type for the outbound call:
1. Click the station appearance drop-down arrow to display the list of available options. Click to 

select the option; that option stays active until a different option is selected. 

Option Description

Start ( ) Begins recording the conversation. 
To start the recording:
•  Click the start action icon in the top left corner of the Device Status area of the main window. 

or
•  Navigate to Current Calls > More > Start Recording.

Pause ( ) Temporarily stops the recording. The icon changes to the resume recording action icon, and the 
applications interrupt recording the conversation.
To pause the recording: 
Click the pause action icon in the top left corner of the Device Status area of the main window.

Resume ( ) Restarts recording the conversation. The icon changes to the pause recording action icon, and 
the applications start recording the conversation.
To resume the recording:
Click the action icon in the top left corner of the Device Status area of the main window.

Stop ( ) Ends the recording, and the application saves the file. 
To stop the recording: 
•  Click the action icon in the top left corner of the Device Status area of the main window. 

or
•  Navigate to Current Calls > More > Stop Recording. 

Note: For information about how to set the location for storing the recorded audio files, see 
“Recording” on page 50.

Option Description
Default Line (by user name 
assigned to that 
appearance)

Place an internal or external phone call.

<other available line 
appearance>

Place a call using the specific line appearance.

Shared Call Appearance Place a call using a specific shared call appearance line.

                                                                                                                                 Continued
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2. With the appropriate option selected, place the call by using one of the following actions: 

• Open the Dialpad and click each digit to dial the number.

• Click in the Dialpad entry field and use the keyboard to enter the number.

• Use the dial pad on the Allworx phone when using the Interact Professional user interface.

• Double-click the appropriate listing in the Contacts pane of the Interact Professional user 
interface window.

• Double-click the appropriate listing in the Call History pane of the Interact Professional user 
interface window.

3. Click Call on the Dialpad.

4. Begin talking using the designated Allworx handset, and then click End Call when finished. 

5.6 Setting the User Presence 
The presence icon in the expanded user interface window shows the user contact availability status. A 
presence other than In Office displays the presence status icon for the selected presence. See “Icons” 
on page 16. 

To change the user presence
1. Click the drop-down arrow in the user presence field in the top left corner of the Interact user 

interface window.

2. Click to select one of the following options from the drop-down list. 

Option Description
<Bluetooth enabled 
device>

Place a call using the Bluetooth appearance. Requires the Verge 9312 IP phone.

Intercom Place an intercom call to Allworx directory contacts only.

•  In Office •  Busy •  On Business Trip •  At Home
•  On Vacation •  At a Meeting •  Away
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5.7 Adjusting Application Settings
The settings icon provides a menu of options to manage the expanded user interface for both Interact 
Professional and Interact Softphone. Click the settings icon ( ) to display the drop-down list and then 
click to select one of following options:

5.7.1 Configuring the Application from the Options Menu
The Option Settings pop-up dialog box is accessed from the settings drop-down list and provides 
additional configuration features for the all Interact application user interfaces. To open the Option 

Option Description

Visible Windows Change the current window view. Use this setting to show or hide windows. When 
changing slide-to-hide windows to visible, pinned is the default behavior.

Audio Devices
(Interact Softphone mode 
only)

Opens the Audio device selection & Volume controls dialog box. Use the controls in this 
box to select the audio devices and ringtone to be used with Interact Softphone and 
adjust the volumes (see “Adjusting Volume Levels and Selecting Audio Devices” on 
page 34 for more information).

Show Active Call Window / 
Hide Active Call Window

Display or hides the incoming, active call pop-up window, respectively.

Update Application Request an upgrade from the portal, if available. Click to begin the update.

Update Interact Sync Display only if an upgrade is available. Click to begin the update.

Options Adjust the Call Notifications, Contacts, Display, External Program Link, Interact Sync, 
Keyboard & Mouse, Recording, and Support (see “Configuring the Application from the 
Options Menu” on page 39 for more information).

View Emergency Alerts
(Interact Softphone mode 
only)

Click to display the pop-up window with any active Emergency Alerts (see “Receiving 
Emergency Alerts” on page 30 for more information).

Change password Update the current Allworx password. See “Changing the Allworx Password or Allworx 
PIN” on page 11 for more information. 

Change PIN Update the current Allworx PIN. See “Changing the Allworx Password or Allworx PIN” on 
page 11 for more information.

Reset UI configuration Reset the application display settings to the factory defaults. Click OK to accept the 
request.

Launch Allworx View Open the View application in the default web browser window for more detailed 
statistics about queues, agents, and calls. Manage the View application as defined in 
the Allworx View Application User’s Guide. 

Find out more Link to the Interact Upgrade Options page.

About Indicate the application version level, copyright, and support contact information.

Logout Sign the user out of the application; enables a new user to log in the application.

Exit Close the application.
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Settings pop-up window: 

1. Click the Settings icon ( ) to display the drop-down list.

2. Click to select Options.

3. On the left side of the Option Settings pop-up dialog box click a tab to select the option to set.

4. After configuring the option, click one of the following actions:

5.7.1.1 Call Notifications
From this tab adjust the preferences for the behavior of incoming call notifications.

Action Description

OK Save the changes and close the Option Settings pop-up window.

Cancel Disregard the requested changes.

Apply Save the changes and allow the user to continue customizing the Interact application.

Preference Description

Location Position of the pop-up notification window on the computer screen. Options include:

Opacity Move the slider bar to adjust the pop-up notification window transparency.

Duration The length of time the pop-up notification window displays. Options:
•  Active calls - When selected, the notification stays open for the entire length of the active call.
•  Timed - When selected, the amount of time in seconds for the notification to remain open must 

also be selected in the adjacent field. (Default is 10 seconds)

•  Lower Right (default) •  Upper Left •  Lower Left
•  Center •  Upper Right
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5.7.1.2 Contacts
Use this option to set the user’s image, manage the personal contacts from external sources, and 
import or export personal contacts. 

Preference Description

Ringing Animation Behavior of the BLF appearance during an incoming call in the Contacts window. Options: 
include: Flash (default), Pulse, and None.

Ringtone family The Ringtone family assigned to the call notification. Select from the drop-down list.

Option Description

My Allworx directory image 
Select an image to store on the Allworx server and associate with your Allworx User Contact entry. This is the image that 
other Allworx users see associated with your caller ID name/number in the directory listing.

Change the image Opens a file explorer dialog box. Navigate to the directory that contains the 
desired image, click to select it, and then click Open to add the image.

Notes: 
•  This option is not available if the Allworx Server Administrator has disabled 

the permission for the Allworx user to manage the contact image.
•  The Allworx Server Administrator can delete an Allworx User’s directory 

contact image.

Clear the image Removes the image file and returns the avatar to the contact silhouette. 

Outlook Integration
Select whether to have Interact retrieve contact information from Outlook.

 Enabled or Disable Indicates the current selected option. Click to select Enable or Disable to 
change the option.
•  If enabled, the Interact application communicates with the Outlook application 

to monitor Personal Contacts for availability in the Interact Professional user 
interface.                                                                                                               

 Enabled or Disable

(continued)

•  If disabled, the Interact applications remove Outlook Personal Contacts from 
the Contacts list. Additionally, the Interact Professional user interface does 
not share the Personal Contacts with other Allworx devices and applications.

Contact Accounts
The Interact Professional user interface can display Personal Contacts on all assigned Allworx applications and devices. 

Accounts on this device Display local contact locations. 
•  If the account settings have not been set, click Choose.
•  If the account settings are set, click Edit to open the Edit account details 

dialog box.
Select one of the available options to change the contact management or click 
Forget account to remove the contacts.

                                                                                                                        Continued
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After managing the My Allworx directory image or the Personal contacts from external sources, click 
Apply. After all configuration changes are complete, click OK.

Option Description

Accounts on other devices Display contact locations synchronized from other Allworx devices.
•  If the account settings have not been set, click Choose.
•  If the account settings are set, click Edit to open the _Edit account details_ 

dialog box.

Select one of the available options to change the contact management or click 
Forget account to remove the contacts.

Import / export personal contacts

Users can import contacts from a CSV or vCard file into the Personal Contacts of the Interact Professional user interface 
which are stored on the Allworx server. Users can also export the personal contacts to a file for backup purposes or to 
import into another application.

Import from file Prior to performing this option: create, save, and close a .CSV file with the 
following fields: 

1.  Selecting this option opens a file explorer dialog box. Navigate to the file 
location, and click Open. 

2.  Use the drop-down lists to select how to map the columns in the CSV file to 
the contact fields. If the .CSV file contains column headings, verify the First 
row contains column headers is checked.

3.  Click OK. A confirmation dialog box appears. Click OK to close it, and then 
click OK to close to the Option Settings dialog box.

Export to CSV file or Export to vCard 
file

Opens a fire explorer dialog box. Navigate to the folder to store the file, and then 
enter a File name in the field. Click Save. The Successful export operation dialog 
box opens and indicates the number of exported contacts. Click OK. 

Refresh contacts Click to update the Contacts pane in the Interact Professional and Interact 
Softphone user interface.

Required Optional
•  Description OR Last Name •  First name •  Login
•  One phone number •  Middle name •  DID DNIS Name

•  DID Prompt 
Language



Allworx Interact Release 5.1 User Guide

866.ALLWORX (866.255.9679) or 585.421.3850 Page 43
www.allworx.com
Version: A Revised: October 21, 2020

5.7.1.3 Display
From this tab choose a color theme for the Interact application user interface by selecting the 
appropriate radio button. There are two display options available.

• Light Theme 

• Dark Theme

The Display tab also provides Sleep Options. Click the radio button to select one of these options:

• Allow Sleep

• Stay Awake

• Stay Awake (Keep Display On)

Preventing the PC from going to sleep keeps users from missing calls.
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5.7.1.4 External Program Link
Use this option to tie the Allworx phone system into a business work flow. Specify one or more actions 
for the Interact software to perform whenever certain phone system events occur and manage 
existing actions to new requirements. Click Add a new rule to get started. 

Rule 1

Rule name Enter the name of the rule in the field provided. The Rule 1 heading changes to match the 
entered description. 

Action to perform

Type of action 1.  Select an option using the radio button:
•  URL - See “To use External Program Link - URL option:” on page 45.
•  command line - See “To use External Program Link - CMD Shell option:” on page 46.

2.  Enter the URL or command line executable.

Macros Shortcut to include in the command line executable. Options:

Click the drop-down arrow and select an option. Click Insert selected macro to add to the 
Command to execute section. Options include:

•  %CALLNUM% (phone number of the caller)
•  %CALLNAME% (name of the caller)
•  %DNISNUM% (DNIS number of the caller)
•  %DNISNAME% (DNIS name of the caller)
•  %COMPANY% (company name of the caller)

•  Only inserts COMPANY when the CALLNUM finds a matching contact in the personal contacts 
and the matching contact has a company assigned.

•  Automatically appends CALLNUM to the end of an API string with no macros.
•  Only inserts DNISNUM and DNISNAME values when available, otherwise the application 

inserts a blank.

Macro Expansion 
Options

Click the arrow to view the drop-down list. 
•  Prepend home area code to local numbers:

•  Strip the external dialing prefix from all phone numbers - Check to select, uncheck to deselect.
•  Strip the country code from all phone numbers - Check to select, uncheck to deselect.

When to perform 
this action

Check the box to enable the requirement when performing the command. Options include:

Select appearances 
(Advanced)

Check the box to select the appearances to use the defined rule. Click OK to save the request.

                                                                                                                                                        Continued

Allworx System Software Version 7.7 or lower

Verify the Home Area Code is available in the Dialing Plan. If there is no Home Area code, 
enter the home area code.

Allworx System Software Version 8.0

Verify the Home Area Code is in the Dialing Plan.
•  If a Home Area Code is unavailable, enter the home area code.
•  If a Home Area Code is available, locate the Prepend the area code <area code configured 

on the server> to all local numbers line and check the box.

•  Perform on inbound calls •  Only execute if a call is answered •  Do not execute for internal 
calls•  Perform on outbound 

calls
•  Only execute if a caller is not in 

the contact list
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To use External Program Link - URL option:
1. In a separate browser window launch the third-party application to use with the External Program 

Link feature. Perform an operation for the information containing one or more of the External 
Program Link macros in the Interact Professional user interface. 

2. Highlight and copy (Ctrl + C) the URL from the browser window. 

Example: Sales Force application Advanced Search using a phone number. www.salesforce.com/
search/SearchResults?searchType=2&str=5854210000&search=Search&sen=0. 

3. Navigate to the Interact Professional user interface and paste the URL in the Action to perform field 
(Ctrl + V). 

4. Replace the macro information (phone number in this example) by highlighting the information 
within the pasted URL, locate the Macros line, and select the correct macro key from the 
drop-down list. Click Insert to replace the highlighted portion of the URL with the macro.

Example: The section in bold in the following URL is the inserted macro for this example:

www.salesforce.com/search/
SearchResults?searchType=2&str=%CALLNUM%&search=Search&sen=0

5. Repeat step 4 for each additional macro substitution within the same URL.

Add a new rule Add a another rule to the External Program Link. Follow the options above to enter the required 
information in the fields provided. Remember users can:
•  add as many rules as necessary. There is no number limit to adding rules. 
•  rename the rule without affecting the rule behavior.
•  reorder the rules for processing purposes.
•  use the Copy button to duplicate an existing rule, and then edit the rule separately.
•  delete rules.

The application processes the rules in the listed order and applies all rules on any given call 
asynchronously. If a call triggers multiple rules, it is possible that the application executes 
multiple (or all) rules simultaneously.

Problem solving

Try an example for 
Rule 1

Display a sample contact and URL based on the information provided in the Command to 
Execute section.

Test this action now Click to verify that the command is valid.

Action history Click the drop-down arrow to display the list of recently performed commands.

https://na13.salesforce.com/search/SearchResults?searchType=2&str=5854210000&search=Search&sen=0
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To use External Program Link - CMD Shell option:
Enter the following command shell script. The examples below use C:\Program Files\CMS\ 
CMSSCREENPOP.EXE as an example of the executable command file.

a. For a completely automated screen pop:

b. For a partially automated screen pop:

5.7.1.5 Interact Sync
Use these settings to configure the Interact Sync plug-in to call a Skype for Business contact and 
adjust the presence settings. 

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username> 
/PASSWORD:<userspassword> /LAUNCH

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username> 
/PASSWORD:<userspassword>

Click-to-dial options

Contacts in Skype for Business can have up to four associated phone numbers. This section configures the phone 
number to use.

Always prompt me for the number to 
dial

Requires selecting the contact phone number after selecting the Allworx Dial... 
option.

Automatically dial the following 
number (when possible)

After selecting the contact, Interact Professional automatically dials the phone 
number. Select which number to automatically dial:

Presence Synchronization Options

Configure the ways the Skype for Business Availability along with Outlook appointments can affect the Allworx Presence 
and phone Do Not Disturb setting. To manage each setting, check the Enabled check box to the right of the heading.

Availability and phone calls

Check the box to enable automatically updating the Skype for Business Availability when using the Allworx phone. After 
the call ends, the Availability status returns to the previous setting. 

When I’m using my Allworx phone, 
modify my Availability 
to

Select from the following options:

Availability and Allworx Presence

Check the box to enable automatically updating the Skype for Business Availability setting with the Allworx presence 
setting and vice-versa. Additionally, scheduled meetings on the Outlook calendar update the Skype for Business 
application, which updates the Interact Professional application. After customizing the settings, the Skype for Business 
and the Interact Professional applications synchronize the Allworx presence and Availability settings.

                                                                                                                                                                                                  Continued

•  Work Phone •  Mobile Phone
•  Home Phone •  Other

•  Available •  In a call •  In a conference call •  Be right back
•  Busy •  In a meeting •  Do Not Disturb •  Away
•  •  
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On initial link-up: Select from the following options:
•  Copy my Availability to my Allworx Presence
•  Copy my Allworx Presence to my Availability

When I am in a call in my Skype for 
Business application and my 
Availability changes to In a call:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

When my PC is idle for a prolonged 
period of time (typically 10 minutes) 
and my Availability changes to Away:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

When I lock my PC and my Availability 
changes to Away:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

Availability and phone DND setting

Check the box to enable automatically updating the Skype for Business Availability using the Allworx phone Do Not 
Disturb setting. When setting the Allworx phone to Do Not Disturb (DND), the Interact Sync changes the Skype for 
Business Availability to Do Not Disturb as well. 

On initial Link-up: Select from the following options:
•  Copy my Availability to my phone DND setting
•  Copy the DND setting from my phone to my Availability

When I lock my PC and my Availability 
changes to Away:

Select from the following options:
•  Do not change the DND setting on my phone
•  Enable DND on my phone

Appointments and Allworx Presence

Check the box to enable automatically updating the Allworx Presence based on new Outlook calendar appointments. 

Default Presence for calendar 
appointments

Select from the following options:

Do not modify my Presence for 
appointments with a “Show As: value 
of:

•  Free
•  Tentative

                                                                                                                                          Continued

•  Away •  At A Meeting •  Busy

•  Away •  Busy

•  

•  Away •  At Home •  Busy •  At A Meeting
•  •  •  •  

•  Unmodified •  On Vacation •  At a Meeting
•  “Show As” based (Outlook feature) •  At Home •  Away
•  In Office •  On Business Trip •  Busy
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5.7.1.6 Keyboard & Mouse
From this tab users can customize keyboard shortcuts for the following application functions:

• Answer Incoming Call

• End Current Call

• Hold Current Call

When entering the shortcut keys, verify that these functions do not conflict with shortcuts used in 
other applications because the shortcuts defined here will affect the PC globally and will work in all 
applications; even if Interact is not the primary application in use.

To set a keyboard shortcut:
1. Set the Enabled check box for a particular Command. 

2. Click on the Keyboard Shortcut field for that command and simultaneously hold down the key 
combination to use.

3. Repeat steps 1 and 2, as necessary, for each phone action.

4. Click one of the following:

Default Presence for calendar 
appointments

Select from the following options:

Override options Temporarily disable synchronization between the Microsoft applications and 
Allworx Presence.
Locate Ignore Availability changes when I manually set my Presence to:, and 
then select the applicable option:
•  On Vacation
•  On Business Trip
•  At Home

Presence change log Display a running log of recent changes to the Allworx Presence and DND for 
debugging purposes.

Action Description

OK Save the changes and close the Option Settings window.

Cancel Disregard the requested changes.

Apply Save the changes and allow the user to continue customizing the Interact application.

•  Unmodified •  On Vacation •  At a Meeting
•  “Show As” based (Outlook feature) •  At Home •  Away
•  In Office •  On Business Trip •  Busy
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To set the Drag-and-Drop behavior for current calls:
Users can configure the application display to highlight colored targets to indicate the supported drag-
and-drop actions. Click one of the available radio buttons to select the drag-and-drop behavior:

• Use legacy drag-and-drop behavior: Drag a call from the Current Calls pane to the Contacts or Call 
History pane using the:

• Left mouse button to perform a Blind Transfer

• Right mouse button to select an operation from a pop-up menu

• Use drop targets: Drag a call from the Current Calls pane to the Contacts or Call History pane. Each 
contact displays one or more colored targets indicating the supported drag-and-drop operations 
onto the target.

While dragging a call, Allworx users can press and hold a key on the keyboard to limit the selection of 
drop targets by entering a filter key (alpha characters only) in the fields provided:

Drag-and-Drop Target Examples

Behavior Description Default Keyboard Shortcut

Blind Transfer Win + Shift + B

Attended Transfer Win + Shift + A

To VM Win + Shift + V

Park To Win + Shift + P

Attended Transfer To VM



Allworx Interact Release 5.1 User Guide

Page 50 866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com

Version: A Revised: October 21, 2020

5.7.1.7 Recording 
From this tab users can specify the storage folder for call recordings, manage the Record All feature, 
and set the recording volume level. 

5.7.1.8 Support
This tab provides fields to enter user optional contact information and instructions for contacting 
Allworx (including the location for saving log zip files).

Users can also select their participation in the Customer Experience Improvement Program that 
automatically provides feedback to Allworx for enhancements to the Interact application. This 
program collects information about how people use the product without interruption to the user's 
phone or computer usage. The information collected helps Allworx to identify feature enhances.

If you choose to participate in the program, the Interact Professional user interface collects statistical 
information about your system configuration, the performance of some components of the Interact 
application, and certain events. The Interact application periodically sends that collected information 
over the Internet for analysis by Allworx developers. If you do not want to participate, click to uncheck 
the check box.

IMPORTANT: The uploaded data contains no information that identifies you, your company, or your 
contacts. There are no surveys to complete; it all happens automatically. If you do not have an Internet 
connection, the application discards the data. Allworx does not share this information with other 
companies; only Allworx uses the submitted information, in aggregate form, for the purpose of 
improving our software for our customers.

Setting Description

Folder to store 
recordings in

The folder to store the recordings displays. 
To change the folder location:
1.  click Browse and navigate to the new location. 
2.  Click OK to set the new destination. The file displays in the folder starting with the username 

and the date.

Record All Automatically captures audio files from the time the  user answers the call or launches the 
application during an active call. See “Recording a Call” on page 35 for more information.
Enabled - Click to select this check box if the user can turn on the Record All calls option locally. 
The default is Off (unchecked).
Enabled by Server Administrator - This check box is selected if the Allworx administrator has 
turned on the Record All option at the Allworx server. Users cannot turn off this setting at the 
local level. The pause, resume, or stop icons are available.

Record volume The slider bar adjusts the volume of the recording. Left for a quieter recording and right for a 
louder recording.



Allworx Interact Release 5.1 User Guide

866.ALLWORX (866.255.9679) or 585.421.3850 Page 51
www.allworx.com
Version: A Revised: October 21, 2020

Chapter 6 User Interface Window
Note: The information in this chapter applies only to the expanded user interface window used with 
Interact Professional and Interact Softphone. 

The user interface window displays up to 9 panes of information that can be independently managed 
and customized. This chapter describes the information contained in each pane and provides 
instructions on how to implement the associated Interact features.

6.1 Active System Calls
Note: Calls on mapped remote handsets do not display in the Active Systems Calls pane.

The Active System Calls pane displays internal and external calls with the following information:

Click the column heading to sort the information.

To change the Active System Calls pane view, contact the Allworx server administrator to update the 
setting for the User System-wide Active Calls Display to one of the following: 

Field Description
Start time Time of day the call began.

Duration Amount of time the call connection is active.

Originator Caller ID Caller ID starting the call.

Destination Caller ID Caller ID receiving the call.

Setting Description
Not Displayed The window does not display.

Brief Display (no Caller ID) Both originator and destination caller ID displays as Private

Full Display (with Caller ID) Caller name and caller ID display.

Hide Active Pane Icon

Active call information

Number of Active Calls
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6.2 Agent: <name>
The Agent pane is available to users who are assigned to a call queue and have an ACD Appearance 
PFK (Allworx desk phone) or Programmable Function (Interact Softphone) assigned. Agents can log in 
and out of call queues as well as select a busy status using the Interact Professional user interface or 
the Allworx desk phone. The Agent pane automatically updates with that agent’s information when 
changes are made.

To log in or log out of a call queue:
1. Click Login/Logout. The Agent Login/Logout dialog box appears and displays a list of assigned call 

queues.

2. Click to check or uncheck the box to select the call queue(s) to log in to or log out of, respectively.

3. Click in the Allworx PIN field and enter the assigned Allworx PIN.

4. Click Apply. 

After logging into one or more call queues, the Login/Logout button displays a blue badge. The 
badge indicates how many call queues the agent logged in to. A red badge with the number 0 
displays when the agent logs out of all call queues. To see the queues the agent is logged in to, 
hover the cursor over the badge on the Login/Logout button. A red flag next to the Allworx PIN field 
indicates an invalid PIN number. 

Agent Busy Status
Can change to:
•  Idle -> Busy
•  Busy -> Busy
•  Wrap-Up -> Busy
•  Wrap-Up -> Idle

Login/Logout

Log in/Log out Window with 
assigned ACD Queues

Hide Window Button
Login/Logout Queue Badge
Red = no logged in queues
Blue = number of logged in queues

Hover over Login/Logout button 
to see logged in queues.

Agent Selectable Status
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To set or clear the agent status:
After logging in to one or more call queues an agent can set the agent status to Busy or Idle. 

Note: The Interact agent cannot change the following Busy States: Ringing, Call on Hold, Administration 
Functions, and On Call.

Click the button displaying the agent status and select the new agent status option from the drop-
down list.

6.3 Call History
The Call History pane loads the user’s call history when first opening the application and then 
continues to provide a listing of the current call history size. For Interact Professional, Verge IP 
phones support 200 entries / 92xx IP phones support 99 entries. For Interact Softphone the maximum 
number of entries in this pane is 200. The pane updates with each call and deletes the oldest Call 
History entry as the application adds new entries to the list. 

Call History listings include: the caller ID (red text indicates a missed call), date/time of the call, and 
status icons. If minimizing the Call History pane so that only the contact image and caller ID name/
number display, hover over the listing to see start date/time and duration of the call. Use this pane to 
place a call, search, change the display order, or clear the call history list. 

Call Status Description
Transferred Call forwarded to another recipient

Ended Normal call ended

Parked <orbit number> Call placed into a Parking Orbit

Parked <extension> Call parked to a specific extension 

No Answer Outbound call that is not answered (internal calls only).                           Continued

Search Field Use drop-down arrow to manage:
•  Display Order
•  Search By
•  Search Preference
•  Clear History

Call History Listings
•  Caller image (if 

available), red corner 
indicates Allworx 
business directory 
contact.

•  Caller ID Name/Number
•  Call information
•  Call status 

Hide Window Icon
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To manage the Call History listings:
1. Locate the Call History listing and right-click on that listing. 

2. Select an option from the drop-down list: 

To complete a search within the Call History pane:
Provide criteria in the search field to locate a specific call history listing.

1. (optional) Click the drop-down arrow next to the search field (indicated by the  icon) to select 
one of the following search preferences.

Call Status Description
Missed Inbound call that rings, but it is not answered.

Check Number Failed to route to an outbound call

Elsewhere Missed inbound, picked up somewhere else, i.e., Reach Device

Option Description
Intercom Place an Intercom call to the listing. 

Dial Place a call to that listing. Shortcut: double-click that listing.

Add to Contacts Open the Edit contact details dialog box. 
•  Enter or update the information.
•  Click OK to add the information as a Personal Contact.

Delete entry Clear that specific listing from the Call History pane.

Delete all Clear the entire list from the Call History window. Click Yes in the confirmation 
dialog box to perform this action.

Details View the Call History listing details - call date/time, caller/contact ID and number, 
call duration, and network statistics. 

Select one of the following actions after opening the Call History Details dialog box:

Preference Description
All Fields (Default) Display listings with any field matching the search criteria.

Full name Display the caller ID names matching the search criteria.                             Continued

Action Description

OK Close the Call History Details dialog box.

Add to Contacts Opens the Edit contact details dialog box. Enter or 
update the information and click OK to add the 
information as a Personal Contact.

Delete entry Removes the listing from the Call History pane.
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2. Enter the search criteria in the field. The application automatically displays the call listings that 
match the search field information in the Call History pane.

To clear the search field criteria, click the X that appears at the right end of the field.

To change the Call History pane display order:
Select how the Call History pane displays the listings.

1. Click the drop-down arrow next to the Search field and select Display Order from the menu.

2. Select the preference. The Call History pane updates the view according to the selection.

To clear all calls in the Call History: 
1. Locate the Call History pane. 

2. Click the drop-down arrow next to the magnifying glass ( ). 

3. Select Clear History from the list.

Note: Performing a Clear History also clears the Handset Call History.

6.4 Contacts
The Allworx System supports four types of contacts on the Allworx® Verge™ IP phone series and on 
Interact Softphone handsets:

• User and System contacts – These contacts have an internal Allworx extension assigned and are 
managed by the Allworx Server Administrator.

• Public Contacts – These are system-wide contacts (formerly known as Speed Dial (for Verge 
phones) and are managed by the Allworx Server Administrator. 

• Personal Contacts – These contacts are managed by the Allworx user and are only available on 
Allworx systems with a Connect server. 
• Allworx Personal Contacts

• Created from the Verge IP phone, the Interact application, or a Reach device contact 
application.

Preference Description
Number Display the caller ID numbers matching the search criteria.

Date/Time Display listings with a date/time stamp matching the search criteria.

Option Description
Name Display the Call History listing by caller ID name.

Number Display the Call History listing by caller ID number.

Time Display the Call History listing with the most recent call on top. (Default setting)
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• Imported from a .CSV file or vCard within the Interact Professional user interface.
• External Personal Contacts

• Synchronized from a Reach device originating application (device app such as Contacts or 
People)

• Synchronized from an account such as a Gmail or Outlook email account.

Visual example of Contacts:

6.4.1 Sharing Contacts
The Allworx system shares the User, System, and Public contact types with all of the Allworx user’s 
connected Allworx phones, Reach devices, and the Interact application modes. Within the Reach and 
Interact application modes, Allworx users control sharing and synchronizing Personal Contacts with 
the devices assigned to that Allworx user. 

Notes:

• The Allworx Connect server is not a contact manager for Personal Contacts. Example: If a Personal 
Contact is available in the Reach device app (i.e. Contacts) and the same Personal Contact is 
available in the user’s email account (e.g. Gmail), the Personal Contact displays twice when viewing 
the contacts.

• The expanded Interact user interface only exports contacts added from within an Allworx 
application.
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• For Interact Professional, the Verge 9304 IP Phone fully supports Allworx User, System, and Public 
contacts while having limited Personal Contact support. Allworx users can add up to 100 Allworx 
Personal Contacts that are only available with that phone - not with other Allworx phones and 
applications (including when using the Hot Desk feature).

• Interact Professional offers full contact support on all phones connected to a Connect server. 
Certain phones (like the Verge 9304 IP Phone, or older Allworx 92xx phone models) have limited 
contact support within the phone (these phones do not automatically match contacts synchronized 
from Reach or Interact applications), but the Interact Professional application mode offers full 
contact support even when used with those phones.

Visual example of sharing contacts using a Connect server: 

6.4.2 Contact Privacy
Allworx users control sharing and synchronizing the Personal Contacts to the devices assigned to the 
user by clicking the Settings icon ( ) and navigating to the Options > Contacts dialog box:

• Choose which contact source accounts (e.g. Outlook) to share with your Allworx devices and 
applications.

• Disconnect a contact source account from other Reach devices. 
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6.4.3 Data Protection
Only the Allworx user has access to their Personal Contacts; the Allworx Server Administrator cannot 
access the user’s Personal Contacts. Allworx Interact Professional users can prevent others from 
seeing the personal contacts on their Verge IP phone by restricting access. This requires the Allworx 
PIN to unlock the Verge IP phone.

6.4.4 Managing Personal Contacts
Allworx users can manage and update Personal Contacts by using the originating device or external 
application (e.g. Microsoft Outlook, Gmail). Only the Allworx user can add, edit, or delete each 
Personal Contact. However, Allworx Server Administrators can delete all of a user’s personal contacts 
from the Connect server permanently, but cannot limit an individual user’s number of Personal 
Contacts stored on a Connect server.

Note: The Reach application allows users to update an External Personal Contact IF the email account 
(e.g., Gmail) used to create the contact is available on the Reach mobile device. However, the Reach 
application does not allow users to update External Personal Contacts synchronized from the Interact 
Professional user interface using Outlook email.

Example: 
Jane Smith needs to update her Personal Contact, Tom Wright. Because Jane uses the Verge IP 
phone, Reach for iOS, and the Interact Professional application with Softphone, she needs to 
determine how she added Tom to her Personal Contacts. Within the Interact Professional user 
interface, Jane opens the Contact pane and scrolls to find Tom Wright. Jane hovers the mouse over 
Tom and locates the Account and Devices lines to learn how she added Tom to her Personal Contacts.
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If the Account line reads:

• Allworx Personal: Jane added Tom Wright using her Verge IP phone, Reach device, or Interact 
application. To update the contact information about Tom, Jane can use her Verge IP phone, the 
Reach application or the Interact (Professional) application. Example: Allworx Personal

• Allworx User, Allworx System, Allworx Public* – The Allworx Server Administrator manages these 
contacts using the Allworx System software. Example: Allworx Users

• Source account: Jane used Reach or Interact to synchronize her contacts with her Verge IP phone. 
There are three synchronized contact labels that may display:
• Email account: Jane used the Reach application to synchronize her contacts from her email 

account (such as Gmail). To update the contact information about Tom, Jane must do so in her 
contacts application. Example: username@gmail.com

• Reach device: Jane used an iOS or Android app (such as Contacts) to manage her contacts 
stored on her device, but the contacts are not associated with a third party service. To update 
the contact information about Tom, Jane must do so on the identified device in the appropriate 
Contacts app on the device synchronizing with the Allworx System. 

Note: Reach for iOS version 11 or higher will look like these contact types due to iOS 11 
restrictions. Example: <Samsung SM-T530NU>.

• Outlook account: Jane used the Interact Professional application to synchronize her contacts 
from her Outlook account. To update the contact information about Tom, Jane must do so in 
her Outlook application. Example: Outlook:\\PersonalFolders\Contacts.

* The only user-editable options for these contacts types are the Favorite status and the choice of 
default phone number on the Verge IP phone, Reach application or Interact application.
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6.4.5 Contact Pane Overview
Use this pane to view or group the contacts, designate favorite contacts, add a new Personal Contact, 
and adjust the view. Expanded Interact user interface users can place calls, search the contacts using 
specific criteria, and change the display order. 

Each contact listing displays a contact image (if available), caller ID name / number, and the favorite 
status. Personal Contacts display the company name (if available). User Contacts display icons to 
indicate a presence status for other than In Office (see “Icons” on page 16) and an availability status 
using color-coded BLF status information.

Search Field

Contact Group Tabs

Hide Pane Icon

Drop-down arrow to select:
•  Display Order
•  Display Visibility
•  Search By
•  Search Preference

Standard View with High Visibility Display

View increase or 

User Contact
•  Favorite
•  Parked call notifications 

(if available to the user)
•  Dial
•  Intercom
•  Details

Public Contact
•  Contact Avatar
•  Allworx Badge
•  Contact Name / Number
•  Speed Dial / Contact Number
•  Favorite

Personal Contact
•  Favorite
•  Dial
•  Details
•  Edit Contact
•  Delete Contact

System Contact
•  Favorite
•  Parked call notifications 

(if available to the user)
•  Dial
•  Intercom
•  Details

Add new Personal Contact

Ultra Condensed with Low Visibility Display
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Hovering over a contact displays a pop-up window with the following information:

To change the Display Visibility within the Contacts pane:
1. Click the drop-down arrow next to the search field and click to select Display Visibility from the list.

2. Select the High Visibility (highlights the entire User Contact Listing) or Low Visibility (changes the 
User Contact listing text color) radio button.

To use the Contact group tabs:
Each group tab adds or removes contact entries from the list. Clicking the group tab toggles the 
contacts view on and off independently of the other group tabs. The group remains active after 
closing and reopening the Interact Professional user interface.

Color Description Color Description
Normal (Black) Handset is idle. Red (flashing)* Handset is ringing. 

Red (solid)* Handset is on an active call. Amber Do Not Disturb.

* If the Allworx User Contact is busy, set the Interact Professional user interface to Notify when available. When the 
Allworx User Contact’s extension is available, a pop-up notification displays. See “To place a call using the expanded user 
interface Call History or Contacts pane:” on page 22.

User, System, or Public Contact Personal Contact
•  Contact image, if available
•  Caller ID name and number
•  Current status / Presence
•  Call duration (active call only)

•  Contact image, if available
•  Caller ID name and number
•  Company name, if available
•  Account - the source account used to create the contact
•  Device - the device used to create the contact - this field is 

visible only for contacts imported from Android, iOS, or 
Outlook.

Group Description

Favorites ( ) Display only Favorite contacts from business and Microsoft Outlook directories.

User Display the Allworx contacts assigned to an Allworx desk phone or Interact Softphone.

System Display the Allworx Call Monitor, Call Queue, Auto Attendant, and System Paging Zones.

Personal Display the contacts synchronized from a Reach device, a Verge IP phone, or Microsoft Outlook.
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To designate favorite contacts:

A blue star (  ) displays in the contact listing to indicate that the contact is a favorite. To designate 
or remove a contact as a favorite, click on the star icon in the contact listing or right-click the contact 
listing and select Favorite from the drop-down list. 

To add a new Personal Contact:
Users can add new Personal Contacts from the Contacts pane. 

1. Click the new Contact ( ) icon to open the Edit contact details dialog box for the new contact. 

2. Enter the required information in the fields provided. Click add phone number to open another 
space for an additional phone number to be included in the Contact information. Click Add an 
image to upload an image file from your computer.

3. Click OK. 

The new Personal Contact displays in the Contact pane.

To edit or delete a Personal Contact:
Users can only edit or delete Personal Contacts that were created from within the Interact application, 
Reach application, or on a Verge IP phone. Right-click the contact listing in the Contacts pane and click 
to select one of the following actions: 

To adjust the contact listing display: 
Click a view adjustment icon to alter the size of the contact listing density from a single-row to multi-
column format. To identify the user status: 

Action Description
Edit contact Opens the Edit contact details pop-up window. Enter the updated information and click OK. 

Delete contact Displays the Delete a personal contact pop-up window. Press Yes to remove the Allworx 
Personal Contact. Click No to stop the deletion.

Option Description
High Density This ultra condensed view displays a single-line entry with the username, phone number, and the 

favorite status icon in a multi-column format based on the width of the pane.

Medium Density This standard view displays two lines of information that include the image (if available), name, 
phone number, and favorite status icon in a multi-column format based on the width of the pane.
A Microsoft Outlook contact has three lines of information that includes the company name, if 
available.

Low Density This view displays a single column listing of the contacts with the image (if available), name, 
phone number, company (if available), and favorite status icon. 
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To place a call:
Right-click on a Contact listing and select one of the following options: 

To pick-up another user’s call from the Contacts pane:
For incoming calls, the contact flashes red. Right-click the contact and select Answer from the 
drop-down list to pick-up the call.

To specify the primary number of a personal contact: 
1. Right-click the contact listing and select Details from the drop-down list. 

2. Locate the contact’s phone number, and click to select one of the available phone numbers. 

3. Click Done to save the changes.

To change the Contacts pane display order:
When changing the contacts display order, the selection remains active after closing and reopening 
the application. 

1. Click the drop-down arrow next to the search field.

2. Click to select the Display Order in the drop-down list. 

3. Click the radio button to select one of the following display preferences. The application window 
updates the view per selection.

Option Description
Dial Places a call to that listing. If more than one phone number is available, select a number from the drop-down 

list. 

Intercom Place an Intercom call to that listing.

Option Description
First Name Arrange the contacts by the caller ID first names.

Example: First name, Last name.

Last Name Arrange the contacts by the caller ID last names. (Default)

Example: Last name, First name, Middle name. (Default)

Company Name Arrange the contacts by the Corporate names (Microsoft Outlook contacts only)

Example: Company name, Last name, First name

Number Arrange the contacts by the caller ID number.

Example: Caller ID number, Last name, First name
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To search within the Contacts pane:
Note: The selected search preference is still active after closing and reopening the Interact Professional 
user interface.

1. Type the search criteria in the field. The application returns any contact listing containing the 
search criteria. 

2. (optional) Click the drop-down arrow next to the search field and click to select Search Preference.

3. Click to select one of the following preference radio buttons. 

4. (optional) Click the drop-down arrow next to the search field and click to select Search By.

5. Click to select one of the following search by radio buttons. 

Note: To clear the search field terms, click the X icon that appears in the right side of the field.

6.5 Current Calls
The Current Calls pane displays all active calls and calls on hold for the Allworx desk phone or Interact 
Softphone connected to the Interact Professional user interface, as well as parked calls for Allworx 
contacts when the user has enabled Parked Call Notifications for that contact. Additionally, users can 
place a call on hold, transfer a call, create a conference call, or end the active call from this pane. 

The applications automatically search the Personal Contacts during a new call and display the contact 
name if the number matches any of the numbers in the contact number list. 

Note: You can close the Interact Professional user interface without affecting the current phone state 
such as disconnecting the current call.

Option Description
Contains Display the contact listings with any of the search criteria.

Starts with Display the contact listings that begin with the search criteria.

Option Description
All Fields (Default) Display listings with any field matching the search criteria.

Full name Display the caller ID names matching the search criteria.

First Name Display the caller ID first names matching the search criteria.

Last Name Display the caller ID last names matching the search criteria.

Company Name Display the Corporate names matching the search criteria (from Microsoft Outlook 
only).

Number Display the caller ID numbers matching the search criteria.
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To avoid disconnecting a call when answering a second incoming call, it is recommended that your 
Allworx System Administrator configure your phone’s Handset Preference Group to enable Auto On 
Hold, or you can configure your Allworx desk phone as indicated in the following table. 

Call Reminder notifications are available to alert users when calls placed on hold have not been 
answered. These notifications are defined by the Allworx system administrator in the Handset 
Preference Group and assigned to the handset using the Allworx System Administrator web page (see 
the Allworx System Software Administrator Guide for information). 

When a call is placed on hold, that entry in the Current Call pane is highlighted, labeled with the 
message Privacy Hold, and an audible reminder plays at the intervals defined in the Handset 
Preference Group. When the user resumes the call the intermittent sound stops, the Current Calls pane 
entry is no longer highlighted, and the Privacy Hold message disappears.

Phone Phone Navigation
92xx IP Phones CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu. When 

prompted to Save to Flash, press the Yes soft key.
Verge IP phone series Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press 

Back to return to the Settings screen and Back again to return to the Idle screen.

Hide Pane Icon

Line #2 Information
•  Caller Image, if available
•  Current State
•  Caller ID Name
•  Caller ID Number
•  Call Duration
•  Call Management Buttons

Line #1 Information
•  Caller Image, if available
•  Current State
•  Caller ID Name
•  Dialed Number Identification Service: the telephone 

number dialed by the caller
•  Call Duration
•  Call Management Buttons/Drop-down Menu

Number of Current Calls



Allworx Interact Release 5.1 User Guide

Page 66 866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com

Version: A Revised: October 21, 2020

To place a call on hold:
See “Placing a Call On Hold” on page 27 for more information.

To park a call:
See “Parked Calls” on page 72 for more information.

To transfer a call using the expanded Interact user interface
1. Locate the Current Calls pane and then the current phone call.

2. Click the More drop-down arrow and click to select one of the following transfer options: 

3. Click a listing in the Contacts, Call History, or Current Call pane or use the Dialpad. The call 
transfers.

Transfer Actions: Use the following actions to quickly transfer calls. 

Option Description
Blind Transfer Place the call unannounced to an extension or external phone number. 

Attended Transfer Place the call announced to an extension or external phone number.

Transfer to my voicemail Place the call directly to that user’s voicemail. This option only: The call transfers 
immediately and no longer displays in the Current Calls pane. 

Transfer to voicemail Place the call directly to another user’s voicemail.

System Park Place the call in a Parking Orbit. The Parking Orbit number for a short period of time.

Park To Place the call into a parking location for a specific user or group (if this feature is 
enabled for users with Allworx System Software 8.5 and higher).

Action Description
Left click and drag Perform a blind transfer by moving the call to a listing in the Call History or Contacts pane. 

Release the left mouse button to immediately connect the two calls. 

When Use drop targets is enabled (default), the call is dragged to the Contact listing in either 
pane, the listing highlights with several colors. Drag the call to the blue area to complete an 
Attended Transfer, to the yellow area to complete a Blind Transfer, to the green area to complete 
a Park to, and the pink area to complete a transfer To VM (voicemail).

                                                                                                                                                  Continued
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Right click a Call 
History listing

Manage a listing in the Call History pane by selecting one of the options from the drop-down list:
•  Dial - Place a call to the selected listing.
•  Intercom - Place an Intercom call to the selected listing.
•  Blind Transfer* - Immediately connect the two calls.
•  Attended Transfer* - Displays a second call listing in the Current Calls pane. After the target 

answers select one of the following options:
•  Transfer - complete the transfer
•  Try Again - drop the current Transferee, and the call is available for an Attended Transfer to 

another listing.
•  Cancel - drop the current Transferee, and the Transferor is able to route the call as 

necessary.
•  VMail Transfer (Allworx Directory only) - place the call directly to the transferee’s voice mail 

box.

Right click a Contact 
listing

Manage a listing in the Contact pane by selecting one of the options from the drop-down list:
•  Favorite - Mark the contact as a preferred listing.
•  Dial - Place a call to the selected listing.
•  Intercom - Place an Intercom call to the selected listing.
•  Blind Transfer* - immediately connect the two calls.
•  Attended Transfer* - display a second call listing in the Current Calls window. After the target 

answers select one of the following options:
•  Transfer - complete the transfer
•  Try Again - drop the current Transferee, and the call is available for an Attended Transfer to 

another listing.
•  Cancel - drop the current Transferee, and the Transferor is able to route the call as 

necessary.
•  VMail Transfer (Allworx Directory only) - place the call directly to the transferee’s voice mail 

box.
•  Park To - Place the call into a parking location for that contact (if this feature is enabled for the 

user with Allworx System Software 8.5 and higher).
•  Details... (Outlook personal directory only) - open the Contact Details window for the user to 

select the primary phone number. 

* The user interface guides the user to potential transfer targets.

** Available only to an Allworx Contact listing.

Action Description
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To create a conference call:
Set up phone-hosted conferences between three parties (3-way conferences). 

1. Place the active call on hold. 

2. Place or receive a second call; the Current Calls pane displays both calls. 

3. Click the More drop-down arrow, and select Conference from the drop-down list to join all callers. 
This connects both calls to a single, active call and the display shows both calls as in conference. 

Note: Placing a call on hold temporarily removes the caller from the conference. To rejoin the 
conference, repeat step 3.

To end a conference call using the Interact Professional user interface:
In the Current Calls pane, locate a call segment and click End Call. Select one of the following options 
from the drop-down list:

Option Description
End This Call Disconnects the specific active call participating in the conference call, and the active 

call no longer displays in the Current Calls pane. The other active call(s) in the 
conference remain active, and the Current Calls pane remains open. 

End Conference Disconnects all active calls participating in the conference call. The pane closes – 
unless it is pinned open.

Continue without me Disconnects the user from the conference call while enabling the other callers to 
continue their conversation. After selecting the Continue without me option, the status 
of the active calls in the Current Calls pane updates to Calls Connected, and then the 
pane closes (unless it is pinned open). 

The Interact Professional application mode does not support this feature on four-way 
conference calls.
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6.6 Dialpad
Use the Dialpad pane to place a phone call. 

To place a call using the Dialpad:
1. Open the expanded Interact user interface Dialpad pane.

2. Dial the number using one of the following options:

• Dial the internal extension.
• Follow the dial plan for an external number. To dial an external number, dial the outside line 

access digit set in the dial plan (usually 9 or 78 + Allworx pin code).
• Immediate line seizure example: 9# or 78 + pin code# > Call > phone number 
• Call connect example: 9 <phone number> or 78 + pin code <phone number> 
• Right-click on the Dialpad entry field and select one of the drop-down options or use the PC 

keyboard to enter the numbers
• Copy text into the Dialing Display Field using Ctrl + v or a right-click.

3. Click the Call active icon to place the call. The Dialpad pane is available to dial additional digits 
during a call (example: Auto Attendant options or PIN entry for the Message Center) without 
needing to press the Call active icon.

Shortcut: Double-click the Call active icon to redial the last number.

4. When the call is dialed, the Call active icon changes to an End icon - click that icon to end the 
current call.

Hide Pane Active Icon

Call Active Icon

Dialing Display Field
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6.7 Messages
Note: This pane is available only when using the Interact Softphone mode.

The Message pane alerts users when a new Voicemail message is received. The pane displays both 
the number of new messages available from within the pane or by dialing the Message Center. The red 
number icon displays the number of new messages. 

Just like other Interact Softphone panes, the Messages tab can be opened and pinned in the user 
interface. When open, the pane displays a list of messages in a reverse-chronological order with the 

Caller ID in bold, and standard play  and stop controls.

Note: New Voicemail message alerts are also displayed in the basic Interact window that displays in the 
lower right corner of the user’s PC.

To listen to Voicemail messages:

1. Click the play icon  to listen to a message.

2. Click the stop icon  to end the playback.

3. Right-click on a message to display the drop-down menu.

4. Click Callback to return the call.

5. Click Mark Read to indicate that the message has been read and remove it from the new messages 
count displayed on the tab.
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6. Click Delete to remove the message listing from the pane. There is NO warning when deleting a 
message -- as soon as Delete is selected, the message is removed from the pane.

Note: You can also call the Message Center by dialing 404 in the Dialpad pane. Enter the user PIN and 
use the Dialpad pane to follow the audio prompts to manage messages.The number of messages 
displayed in the Messages pane is updated based on the user’s selections.

6.8 Outside Lines
The Outside Lines pane provides visual indication of which outside phone lines are in use and is only 
available if the Interact Professional user has an outside line assigned to the handset. Use the Outside 
Lines pane to answer incoming calls, seize a line for outgoing calls, drag-and-drop an external contact 
or listing from the Contacts or Call History pane to place a call. 

Use this pane to place an call or answer a call. 

To place a call:
A red highlighted phone line option indicates that the line is unavailable.

1. Open the Outside Lines pane.

2. Select one of the following options:

3. Use the Current Calls pane to further manage the call.

To answer a call:
1. Open the Outside Lines pane.

2. Click the red, blinking phone line.

3. Use the Current Calls pane to further manage the call.

Option 1 Option 2

1.  Click on an available phone line. 

2.  Locate the Dialpad pane. Enter the number and click 
Call.

1.  Locate the Contacts or Call History pane, and then 
locate the external contact.

2.  Drag and drop the contact to an available line in the 
Outside Lines pane.

Available outside phone line:
Blinking – red lines are ringing.

Solid – red lines are unavailable.

Hide Pane Icon
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6.9 Parked Calls
Place a call in a system-wide hold location so that another phone can retrieve the call. The Allworx 
System provides two methods to park a call:

• System Park: Place a call into the next available park location, and then a different phone can 
retrieve the call by dialing the park location number. 

Example: Park a call for someone away from their phone, and then page the recipient to tell them 
to retrieve the call by dialing the parking orbit.

• Park to Extension: Place a call into a parking location for a specific user or group, if enabled 
(available in Allworx System Software 8.5 and higher). Allworx users also receive Parked Call 
Notifications, if someone parked a call on their extension or any extension of interest.

To Park a call when using Allworx System Software 8.5 or higher: 
Locate the call in the Current Calls pane, and then do one of the following:

• In the Current Calls pane, click the More drop-arrow, and then select one of the following:

• Click and drag the current call to the Parked Calls pane to one of the following drop targets:

• Click and drag the current call to the Park To area of the Contacts or the Call History pane. Contacts 
with Park to Extension enabled display the Park To target. To show only parkable extensions, press 
a filter key (default P) while dragging the call.

To park a call when using Allworx System Software 8.4 or lower:
Do one of the following:

• Drag and drop the call listing in the Current Calls pane to the Parked Calls pane. 

• Locate the Current Calls pane and then the current phone call. Click the More drop-down arrow, and 
select Park from the drop-down list. 

In any Allworx System Software version, after the Allworx phone parks the call, the Parked Calls and 
the Current Calls panes update with the call listing.

System Park Place the call into the next available parking location for any Allworx 
phone to retrieve.

Park To Place the call into the next available parking location for a specific 
extension. Use the Contacts or Call History pane to select the contact 
number to which the call is parked.

Note: The panes display only the Contacts with Park to Extension enabled.

System Park Place the call into the next available parking location for any Allworx 
phone to retrieve.

Park To Myself Place the call into the next available parking orbit for this extension.
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To retrieve a parked call:
Locate the call in the Parked Calls pane and click Retrieve or double-click the listing. The Allworx 
System allows retrieving any parked call in the Parked Calls pane.

Interact Professional and Interact Softphone Park Examples (Allworx System Software 8.5 and 
higher):

6.9.1 Parked Call Notifications
The Park to Extension feature notifies users configured to receive parked calls or Park to Extension 
recipients of interest about a parked call.

Example: 
After the Allworx Server Administrator enables the Park to Extension feature on Bob’s extension, Bob’s 
devices automatically notify him when someone parks a call to his extension. In addition, if Bob has a 
Park to Extension programmable button on his Verge phone for the Sales Department, the Allworx 
System automatically notifies Bob of any calls parked on the Sales Department extension. 

The Interact Professional notifications include:

• Notification pops up similar to an incoming call notification

Call History pane > 
Park To Target Available

Current Calls pane > 
More drop-down arrow options

Parked Calls pane

Contacts pane > 
Park To Target Available
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• Updated Parked Calls pane (All parked calls enabled) with the Parked Calls listing

• Updated Current Calls pane with the Parked Calls pane listing and a parked status

Parked Call Notification Examples: 

To enable or disable the parked call notifications: 
1. Locate the Contacts pane.

2. Right-click the contact listing and then click to select the check box to enable Parked call 
notifications, or click to de-select the check box to disable notifications.

6.9.2 Parked Call Listings
The Parked Calls pane displays parked calls. In Allworx System Software version 8.5 or higher, the 
Allworx Server Administrator sets the Parked Calls pane display for viewing the following the types of 
parked calls in the order listed with the longest park time at the highest level for each category. 

Allworx System Setting

All Calls Limited
Calls parked for the phone owner

Calls parked using this phone

Calls for system extensions enabled for notifications

Calls for user extensions enabled for notifications

Calls parked for the extension of configured Park to Extension programmable 
buttons
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Note: Allworx phones do not provide notifications for calls that are not eligible for the parked calls list 
on the phone, even if the owner has set the notification flag for other contact with parked calls.

When viewing many parked calls, users can use the search field to locate a specific call by entering 
one of the following criteria:

• Recipient’s extension contact name

• Caller’s caller ID

• Recipient extension

Parked Call Listings Example:

Calls matching a System Extension Contact (example: Sales Dept) without 
notifications

Calls for user extensions without notifications

System parked calls

Allworx System Setting

All Calls Limited

All parked calls: 
displays all Parked 
Calls on the Allworx 
System.

Parked by me: displays only the calls 
parked by the Interact Professional user.

Notification: 
indicates that the 
Interact Professional 
user wants to be 
notified when calls 
are parked for that 
recipient.

Search field: enter criteria 
about a specified park call.

Retrieve button: click to answer 
any parked call.
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6.9.3 Reminder Period
If the parked call recipient does not retrieve the call within the time configured, the Verge IP phone and 
Interact Softphone provide a notification to the user. See the Verge IP Phone Series User Guide to 
configure the Reminder Period setting on the phone. Interact Softphone Reminder Periods are 
configured by the Allworx Administrator on the Allworx System Administration web page.

6.9.4 Call Route Settings
For Park to Extension only: After the timeout period expires, the call follows the next call handling step 
defined per the extension setting:

• User Extension: Defined in the current presence settings of the recipient Allworx User extension 
configuration. Allworx users with permissions can adjust the Park To Extension timeout and call 
handling using My Allworx Manager. 

• System Extension: Defined in the Day/Night mode settings of the recipient Allworx System 
extension configuration is handled by the Allworx Server Administrator.

6.10 Queue Status
The Queue Status pane displays the Call Queue and ACD Queue information when the user is a 
supervisor or agent of the queue, and/or has a Ring All PFK (Verge phone) or Programmable Function 
Queue Appearance or ACD Appearance (Interact Softphone) assigned to the handset. Additionally, the 
Queue Status pane provides a shortcut to the Allworx View application. 

To answer an ACD call without logging into the ACD queue:
Connect to the call with the longest wait time. Right-click the ACD queue name > Answer Call.

Agent Status
Information

Queue
Information

Hide Window 
Icon
Shortcut to 
Allworx 
View
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To identify the Queue Line information:
All information is available to the queue agent. For Ring-All queues only: the window displays all 
information except Agents Logged In. 

The Queue Line provides the following information:

To identify the Agent Status information:
Only queue supervisors can see this information. Click the arrow to the left of the queue description.

6.10.1 Accessing the View Application
Access detailed Allworx phone system data and usage reporting. Click Launch Allworx View to open 
the View application in the default web browser window, and then manage the View application as 
defined in the Allworx View Application User’s Guide. If the Launch Allworx View option is unavailable, 
the Interact Professional user interface periodically checks for View availability.

6.10.2 Queue Alarms
Alarms are available that alert the users in the Supervisor role when the wait time for a call within the 
queue and/or the queue depth have reached defined maximums. These maximums are defined by the 
Allworx System Administrator using the Allworx System Administration web page to assign PFKs to 
an Allworx desk phone or Programmable Functions to Interact Softphone.

When either alarm threshold has been reached, the listing for the queue in the Queue Status pane 
flashes in either yellow or red, depending on the severity of the alarm. If enabled, an audible alarm also 
sounds. 

Information Description
Queue Description* Name of the queue.

Queue Distribution Mode* Identifies the calls distribution method:

Agents Logged In Identifies the number of logged in agents in the queue.

Longest Wait Time* Period of time the oldest waiting call is in the queue.

Calls in Queue* Identifies the number of unanswered calls waiting in the queue.

Field Description
Agent Displays the agents assigned to the queue.

State Identifies agent status.

Reason Identifies the agent busy state.

Duration Identifies the amount of time the agent in the current state except for the logged out 
state.

Active Queues Identifies the queue when the agent is currently handling a call.

•  Ring All •  Linear 
Priority

•  Sequential Round Robin •  Fairness - Longest 
Idle

•  •  •  •  
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To end the alarm, right-click on the queue entry and select either Silence alarm or Dismiss alarm from 
the pop-up menu.

A similar alarm can also be defined for when there are no agents logged in to a queue. Similarly, the 
entry for the queue flashes yellow or red and an audible alarm sounds. For this alarm, right-click on the 
queue and select Silence alarm, Dismiss alarm, or Answer Call from the pop-up menu.
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Chapter 7 Interact Sync
Interact Sync is a customizable plug-in that enables click-to-dial capabilities between Interact 
Professional and Interact Softphone and installed versions of the Skype for Business 2015 or 2016, 
and Microsoft Outlook 2010, 2013, and 2016 applications, as well as the Google Chrome and Mozilla 
Firefox web browsers. Additionally, Interact Sync supports synchronization between Allworx Presence 
and Skype for Business Availability, Microsoft Outlook meetings, and the Allworx handset. When 
manually changing a presence or Availability status in one application, the other application 
synchronizes to that status. To customize the Interact Sync feature, see “Configuring the Application 
from the Options Menu” on page 39. 

When manually selecting a Skype for Business Availability, or an Interact Professional user interface 
Presence setting, the applications synchronize and display the following respective settings:

7.1 Set Interact Sync as the Default Dialing Application 
While installing the Interact Sync application, the following occurs on the Windows operating system:

Windows 8
• If there is already a default TEL protocol handler, Interact Sync does not register as the default TEL 

protocol during installation. To register the Interact Sync plug-in as the Windows default dialing 
application on the PC:

• Click Start > Control Panel > Default Programs.

• Click Set your default programs. 

• Locate and click Allworx Interact Sync > Choose defaults for this program. 

• Check the box next to TEL, and then click Save. The Windows operating system saves the 
changes.

• If there is not a default TEL protocol handler, the operating system registers the Interact Sync 
application as the default TEL protocol handler during installation. 

Windows 10
After installing the Interact Sync application, the Windows 10 operating system displays a pop-up 
message asking the user to select the TEL protocol handler to use when performing a TEL function. 

Interact Professional Presence Skype for Business Availability
In office Available
Busy Busy
(Unaffected) Do Not Disturb
Away Be Right Back
At Home Off Work
Away Appear Away
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To use the TEL protocol:
Perform one of the following:

• Executing a TEL protocol from the Windows Run dialog box.

• Click the PC Start icon.

• Locate the search field, type RUN in the field, and hit enter. The RUN window opens.

• Type tel: <phone number> in the field, and then click OK. The Allworx phone connected to 
the Interact Professional application automatically dials the number.

• Double-click a Windows shortcut that points to a TEL protocol.

• Locate the Windows shortcut and double-click.

• Locate the <type> Document tab. Verify the number is correct and click OK. The Allworx phone 
connected to the Interact Professional application automatically dials the number.

• Supports the TEL protocol if the web page supports TEL protocol.
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7.2 Click-to-dial with the Google Chrome or Mozilla Firefox 
Web Browser

Easily click-to-dial a phone number on a Google Chrome or Mozilla Firefox web page using the Interact 
Professional user interface (with an Allworx desk phone or Allworx Interact Softphone). Users can 
navigate to a web page, click a phone number to dial, and automatically send a call from the Allworx 
handset connected to the Interact application. 

To select the number to dial:
Select one of the following options:

• Click the enabled Allworx logo, and then select a detected number in the drop-down list. If Interact 
Sync does not detect any phone numbers, the Allworx logo is disabled. Examples below are from 
Mozilla Firefox web browser (Google Chrome browser displays the Allworx logo in the URL 
Address bar).

• Place the cursor over the phone number listed on the web page – the cursor changes from an 
arrow to a hand. Click the number.

Phone number detected No phone number detected
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• Highlight and right-click the phone number on the web page. 

To disable Interact Sync within the Mozilla Firefox web browser:
Navigate to Open menu > Add-ons Manager > Extensions > Allworx Interact Sync for Firefox > 
Disable.

To disable Interact Sync within the Google Chrome web browser:
Navigate to Open menu > Settings > Extensions > Allworx Interact Sync for Chrome and then uncheck 
the Enable check box.

7.3 Click-to-dial with Microsoft Outlook
Click-to-dial a Microsoft Outlook 2010, 2013, or 2016 contact with the Interact Professional 
application and a connected Allworx desk phone.

Interact Professional users can right-click any Outlook contact and then Allworx dial to see the 
available phone number information (except FAX numbers). After selecting a phone number, the 
Interact Professional application automatically sends a call from the connected Allworx handset to the 
Outlook contact.

The Allworx dial menu is available in the following Outlook screens: 
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• People tab > Contacts List (2 options)

• Email > To field

7.4 Presence Synchronization with Microsoft Outlook
Easily synchronize Allworx Presence with Outlook calendar appointments.

When creating or modifying an Outlook appointment, the Set Default Presence setting in the Outlook 
tool bar enables selecting an Allworx Presence setting for an appointment. The Allworx Presence 
status automatically updates through Interact Professional for the duration of the appointment, and 

Option 1
1. Right click the contact.
2. Click Allworx dial…
3. Click the contact phone number to dial.

Option 2
1. Click the ellipsis for more options.
2. Click Allworx dial…
3. Click the contact phone number to dial.

1. Right click the email addressee.
2. Click Allworx dial…
3. Click the contact phone number to dial.
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then restores to the original value once the appointment is finished. The Allworx Presence changes to 
the pre-appointment state after exiting the Interact Professional application. 

When the Allworx Presence setting is not set for an appointment or is explicitly set to use the default 
setting, the user’s Allworx Presence status updates to the default value for the duration of the 
appointment. Users can configure the Allworx Presence value in the Interact Sync options screen in 
Interact Professional or by selecting the default Presence in Outlook.

Users can also modify an Allworx Presence based on the “Show As” value for the given appointment. 
The Show As value of an appointment maps to an Allworx Presence according to the following:

Outlook “Show As” Value •  Free
•  Tentative

Working 
Elsewhere

Busy Out of Office

Allworx Presence Value Does not change the user’s 
Presence

On Business Trip At A Meeting Away

Use Default: displays a drop-down 
list to select which Allworx Presence 
setting to use while the meeting or 
appointment is in progress.

Allworx...:check the box to enable the 
synchronization. Use the drop-down 
list to select the default presence, and 
then click OK.
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Chapter 8 Troubleshooting

Condition Description Solution

Installation

Interact application 
provides “Could not 
access VBScript 
runtime for custom 
action” error 
message.

McAfee anti-virus is interfering 
with the installation of the 
Allworx Interact application.

User must do a complete removal of McAfee anti-virus, using 
the MCPR.exe tool. 
1.  Navigate to Start > Control Panel > Programs and Features.
2.  Locate the McAfee software, and click the Uninstall button 

at the top of the list.
3.  Download the MCPR.exe tool from http://

download.macafee.com/products/licensed/
cust_support_patches/MCPR.exe.

4.  Run the tool.
5.  Download Microsoft Fixit 50842.msi from http://

go.microsoft.com/?linkid=9804433.
6.  Run the tool.
7.  Reboot the computer.
8.  Install the Allworx Interact Professional software.

Note: The Allworx Interact Professional application requires an 
additional un-install and re-install.

Warning message 
during the Interact 
application uninstall 
process.

In Windows, users can install 
Interact for multiple user 
accounts.

Click Continue to uninstall the Allworx Interact application. This 
does not affect other installations of the Interact application.

The current Interact 
application version 
level does not match 
the Control Panel > 
Programs and 
Features > Uninstall or 
Change a program 
version level after 
upgrading the 
application.

Control Panel > Programs and 
Features > Uninstall or change 
a program page reports the 
application installed version, 
not the upgraded version.

The Windows un-installer works without regard to version level 
reported in the Control Panel > Programs and Features > Install 
or Change a program page.

http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://go.microsoft.com/?linkid=9804433
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During install the 
following message 
displays: 

You do not have 
sufficient privileges to 
complete this 
installation for all 
users of the machine.

Log on as the 
administrator and 
retry this installation.

Insufficient PC privileges to 
install Interact Sync.

Interact continues to install. The Interact Sync application and 
features are unavailable.

I believe the following link needs updating...

User must run Interact Sync installer as administrator. Interact 
Sync installer is located at: 
%localappdata%\Allworx\Interact\<current 

Login

Receiving a Windows 
Security Alert dialog 
window when clicking 
the Find Server IP 
button.

Windows users with limited 
privileges are clicking the Find 
Server IP button, and the 
firewall exception for the 
application may not exist. 

Click OK to close the Windows Security Alert dialog window. 

To add the Allworx Server IP:
•  Ask the Allworx administrator the IP address of the server, 

and enter the IP address manually.
•  Ask the Allworx administrator to add a firewall exception on 

the workstation for the Interact application.

The Interact 
application detects an 
upgrade is available, 
but user sees an error 
message when 
attempting to 
upgrade.

The Interact application 
detected an upgrade.

Exit the application by clicking the icon in the Windows System 
Tray, and click Exit. Restart the application.

The Interact 
application feature 
does not work as 
described.

The Interact application 
features are missing or don’t 
work properly.

Verify that the Interact application is the latest version.

Password failure The Interact application does 
not accept the newly changed 
password.

The new password or PIN does not meet the Allworx System 
Software requirements. Contact the Allworx administrator for 
the password/PIN requirements.

Logged in, application 
opens, but it is not 
available on the 
screen.

The Interact application was 
minimized to the Windows 
System Tray prior to the last 
application exit.

To open the Interact Professional user interface to full screen:
1.  Locate the Windows System Tray (lower right corner of the 

screen - typical).
2.  Click the Allworx icon (red circle with white lowercase “a”). A 

drop-down menu displays.
3.  Click Open. The user interface displays full screen.

Condition Description Solution
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Messages

Message displays: 
Communication with 
phone has been lost. 
Attempting to 
reconnect.

The Interact application has 
lost contact with the phone 
and is attempting to 
reconnect.

Verify the following connections:
•  Phone
•  Computer
•  Network activity

Verify phone is not rebooting.

If the Allworx administrator rebooted the phones, restart the 
Interact or Interact Professional application.

Message displays: 
Reconnecting with the 
phone.

The Interact application 
connection to phone was lost, 
and is actively attempting to 
reconnect.

Verify the following connections:
•  Phone
•  Computer
•  Network activity

Verify phone is not rebooting.

Message displays: 
Not receiving audio. 
Contact your system 
administrator.

While recording, no incoming 
data was received. May 
indicate a firewall issue.

Verify the firewall on the PC enables the Interact application as 
an exception. Contact the system administrator.

Message displays: 
The recording 
directory file system is 
full. Recording has 
been stopped.

The call recording storage 
directory has no more storage 
space available.

Move or delete older call recording files or designate a new 
location to store call recording files. See “Begin talking using 
the designated Allworx handset, and then click End Call when 
finished.” on page 38 for more information.

Manage Calls

Cannot place a call on 
an outside line.

Cannot access an outside 
phone line.

Dial the outside line access digit set in your dial plan - usually 9 
or 78+PIN code. 

If this does not work, verify with the Allworx administrator that 
the outside line access information based on the Dial Plan 
External Dialing Rules.

Current active call 
drops when selecting 
Dial or Intercom 
features.

Handset not configured to 
automatically place the 
current call on hold so that 
user may place another call.

Configure the Allworx handset. On the handset, navigate to 
CONFIG > Preferences > Auto On Hold. Select Enabled and exit 
the handset configuration menu. 

The Intercom Call 
option does not work.

The 9202E model Allworx 
phone does not support 
Intercom Calls.

The 9202E model Allworx phone does not support Intercom 
calls.

Selected Interact 
contact does not dial 
correctly.

Interact user selected an 
Interact contact to dial with a 
local number that requires 
dialing an area code.

The Allworx Administrator must add the local area code into the 
Allworx server dial plan, but the Allworx server strips the “9 + 1” 
from the entered phone number.

The Allworx Administrator must configure the Allworx server so 
that the send digits as dialed on the outside line is disabled.

Condition Description Solution
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An error message 
displayed when the 
recording drive is 
unavailable.

While recording an Interact 
call, the drive specified to 
store the recording file 
becomes unavailable.

Do one of the following:
•  Restore drive connection.
•  Select a new location to store the recording file.
•  Cancel the recording. The file will be lost.

Windows

The undocked Parked 
Calls window is 
empty.

The undocked Parked Calls 
window does not populate 
after selecting More > Park or 
when doing a drag and drop.

Verify with the Windows Administrator that the Interact  
application is on the same network as the handset and network 
routing is consistent.

Not all the panes 
display in the Interact 
Professional user 
interface. 

The Visible Windows setting 
was changed.

The user may not have server 
permissions to display certain 
windows.

Navigate to Settings > Visible Windows and select the windows 
to display.

Verify the correct permissions to view active system calls. Also, 
the outside lines window does not display if the her does not 
have any outside lines defined for the handset.

Cannot find the 
personal contacts in 
the Contact pane.

Outlook Interact contacts do 
not display in the Interact 
Professional user interface 
Contact pane. 

The Interact Professional user interface requires the Outlook 
2010 application to be open prior to launching the application.
1.  Close the application.
2.  Launch the Outlook 2010 application.
3.  Restart the Interact Professional application.

The Outlook contacts are now available within the Interact 
Professional user interface.

Agent is in an 
unknown state.

The agent logged out of the 
Interact application while the 
application was in a hibernate, 
sleep, or screen lock state.

Restart the Interact application.

The Agent option for 
Interact Softphone is 
not included in the 
Visible Windows list.

The Agent <user name> pane 
is not visible and is not able to 
be selected as an option in the 
Visible Windows drop-down 
list. 

Contact your system administrator to verify that the user has an 
ACD Programmable Function defined for the Interact Softphone 
handset.

Interact Sync

Interact Sync is not 
working.

The Interact Professional 
application is not 
synchronizing with Skype for 
Business application.

The Interact Sync application requires the Skype for Business 
2015 or 2016 application to be running. Interact Sync does not 
work with earlier versions of Skype for Business.

Condition Description Solution
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The Interact 
Professional user 
interface presence 
setting is not 
synchronizing 
properly.

The synchronization between 
the Skype for Business 
application and the Interact 
Professional application is not 
updating properly.

Do the following:
•  Check the Skype for Business client is updating properly.
•  Verify the Interact Sync feature key and application are 

installed.
•  Check the settings in Settings > Options > Interact Sync.
•  Shutdown Skype for Business and Interact Professional, and 

then restart in the following order:
•  Skype for Business
•  Interact Professional

The Interact 
Professional user 
interface Presence 
does not change per 
the Outlook calendar.

The Skype for Business 
application does not 
synchronize with the Outlook 
calendar availability, which 
synchronizes with the Interact 
Professional user interface 
Presence setting. 

Do the following:
•  Schedule meetings in advance. 
•  Check the Skype for Business client is updating properly.

The Allworx Presence 
is not changing with 
the Outlook 
appointments.

The Outlook calendar is not 
syncing the Allworx Presence.

Check the following settings available at Settings > Options > 
Interact Sync and verify:
•  The Presence Synchronizations options check box is enabled 

(checked).
•  The Override options are not enabled (unchecked) - e.g., On 

Vacation, On Business Trip, or At Home.
•  The Appointments and Allworx Presence > Default Presence 

for calendar appointments: is set to the “Show As” based 
option.

•  The Appointments and Allworx Presence > Do not modify my 
presence for appointments with a “Show as” value of: 
overrides are not enabled (unchecked) - Free or Tentative.

The Outlook welcome 
screen displays.

User does not have an Outlook 
profile and does not expect to 
see this screen.

Interact Professional user interface automatically retrieves 
contacts from Microsoft Outlook, regardless if there has never 
been an Outlook profile created. 

Miscellaneous

The Interact 
application does not 
respond. When 
starting Task 
Manager, the 
application does not 
display in the 
Applications tab.

Only running applications with 

a sustained window showing 
display in the Task Manager 
Applications list. 

1.  Open the Task Manager and click the Processes tab. 
2.  Locate InteractStartup.exe and right click on it. 
3.  Click End Process to close the application.
4.  Re-launch the Interact application.

Condition Description Solution
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The font does not look 
crisp.

Windows XP users may 
experience bit mapped fonts 

within the Interact Application.

1.  Navigate to the computer desktop and right-click on the 
desktop. Select Properties from the drop-down list. The 
Display Properties control panel box displays.

2.  Click the Appearance tab, and then the Effects button.
3.  Click the check box “Use the following method to smooth 

edges of screen fonts”.
4.  Click the drop-down arrow and select Cleartype. 
5.  Click OK, and then click Apply, and then click OK to save the 

changes.

The recording 
directory no longer 
exists. Please check 
the file system.

The call recording storage 
directory is not available.

Verify the directory is still available or designate another 
location to store the call recording files. See “Begin talking 
using the designated Allworx handset, and then click End Call 
when finished.” on page 38 for more information. 

Cannot find the 
Launch Allworx View 
button.

The Launch Allworx View 
option is not available in the 
Queue status window, the 
Device Status Options 
drop-down list, or the System 
Tray options.

The Launch Allworx View option is unavailable until the Allworx 
administrator installs the View CDR feature key and establishes 
a connection between the Allworx server and the View server.

Interact is unable to validate the default View application link.

Unable to update the 
contact image.

The option to upload a 
directory contact image is 
unavailable.

The Allworx Server Administrator has disabled the ability to 
upload a directory contact image. Contact the Allworx Server 
Administrator to enable this option.

Directory contact 
image is gone.

Added a directory contact 
image, but it is no longer 
available

The Allworx Server Administrator has deleted the contact 
image. Replace with a new image.

An alert icon ( ) 
appears to the right of 
the Interact Softphone 
Presence drop-down 
list.

This icon displays on the user 
interface as an error 
message, such as BLF lost, 
Interact lost connection, 
Running out of recording 
space, etc. 

Detailed information about the error condition can be seen by 
hovering the mouse cursor over the alert icon.

Condition Description Solution
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Appendix A Task Table
The Interact Professional user interface provides a wide range of options for managing calls. The 
following table is useful as a reference for locating varying instructions for some of the most common 
call management tasks discussed throughout this document.

 Call Management Task Link to Instructions

Answering a call •  “To answer a call from the pop-up dialog box:” on page 25“To 
answer another user’s call from the expanded user interface 
Contacts pane:” on page 26

•  “To pick-up another user’s call from the Contacts pane:” on 
page 63

Placing a call •  “To place a call using an Allworx desk phone:” on page 22

•  “To place a call using the expanded user interface Call History or 
Contacts pane:” on page 22

•  “To place a call using the expanded user interface Dialpad pane:” 
on page 23

•  “To answer a call from the pop-up dialog box:” on page 25

•  “To place a call:” on page 63

Placing a call on hold •  “Placing a Call On Hold” on page 27

•  “To place a call on hold:” on page 66

Ending a call •  “Supervising a Call” on page 28

Transferring a call •  “To transfer a call using the expanded Interact user interface” on 
page 66

Parking a call •  “To Park a call when using Allworx System Software 8.5 or higher:” 
on page 72

•  “To park a call when using Allworx System Software 8.4 or lower:” 
on page 72

•  “To retrieve a parked call:” on page 73

Muting a call •  “Muting a Call” on page 34

Supervising calls “Supervising a Call” on page 28

Placing an intercom call •  “Placing an Intercom Call” on page 29

Creating a conference call “To create a conference call:” on page 68

“To end a conference call using the Interact Professional user 
interface:” on page 68

Recording a call •  “To record an active call:” on page 37
Continued
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 Call Management Task Link to Instructions

Managing Voicemail messages “Messages” on page 70

Managing contact information and images “Contacts” on page 55

Managing user presence settings •  “To change the user presence” on page 38

Handling queue calls •  “To answer an ACD call without logging into the ACD queue:” on 
page 76

•  “To identify the Queue Line information:” on page 77
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